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How Do | Edit The Page Layout? (copied)

Below are instructions on how to change the page layout of a word doucment. Components of
the page layout include page orientation, formatting columns, and adjusting margins.

Change the page layout

1. Once you are in the word document, select the layout tab.
2. Then select the orientation tab.

3. In the drop down box, select landscape.
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Format text into two columns
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1. Select the layout tab.

2. Then click on the columns tab.

3. Finally, select two.
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Adjust the top margin

coee IT a3 8 s Document1

Home inse’™ Design Layout References Mailings Review View

= — Indent Spacit
D - o I + |EE|s =+ & ne Numbers » neen ——

»= Left: | O 23S mefore: Dpt =

H gation * — ~ = Position  Wrap Bring Send Align Group Rotate
v =4 Right: 0" = :2 After: 0pt Text  Forward Backward

| Last Custom Setting o - S N .
T Z 1 3 ; F 3

I I:l Top: 1.7, Bottom: 0.5", Left: 1", Right: 1 al ¥ Al

Normal

Top: 1%, Bottomn: 1%, Left: 1", Right: 1
{ I:I Narrow

Top: 0.5", Bottom: 0.5", Left: 0.5", Right: 0.5" o

4
l:l Moderate
Top: 1", Bottomn: 1", Left: 0.756", Right: 0.75

11 Wide

Top: 1%, Bottom: 19, Left: 2, Right: 2 e

| Mirrored
l:l Top: 1", Bottomn: 1", Left: 1.25", Right: 1"

Custom Margins...

ar|4 e

1. Select the layout tab.
2. Then click on the margins tab.

3. At the bottom of the list of margins you will see Custom Margins, click into Custom Margins.
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Margins Continued

pt
pt

aran

Layout

°ﬁ Top: |2
"

Bottom: 1"

Left: |1

Right: 1"

Gutter: 0"

Gutter Position: | Left &

Pages
Mirror margins e

Apply to: | Whole document

Default... Page Setup... Cancel OK

4. After you click into Custom Margins, this box will appear. Change the top margin from 1" to 2".

5. Afterward, click ok.

Keep in mind you are only changing the top margin, keep the sides and bottom margin
the same.

Created by Mallory
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How Do | Format Columns and Margins?

Below are instuctions on how to format columns and margins in a word document.

Formatting columns

Home Insert Desig~

References Mailings Review View

|—I y . Indent Spacing
- - - v i

= g = :Z Before: | O pt
s Orientation  Size

| o i l¥=
Right: = 0" . a= After: 0 pt
r :

1
Y -
o >

Three

= -
2 o
g 3
5

=£| More Columns...

1. Select the Layout tab.
2. Click Columns.

3. Select the number of columns.
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Adjusting margins

Home Insert References Mailings Review View
~, = o I o dent Spacing
@ " i [‘—- — r1 " »= o £ 32 Before: Opt =
[ =e right S L13E amter  opt 0 °

Last Custom Setting
Top: 0.7", Bottom: 1", Left: 1", Right: 1

Top: 1%, Bottom: 1", Left: 1", Right: 1

MNarrow
Top: 0.5", Bottom: 0.5", Left: 0.5" Right: 0.5"

MNormal ‘

Moderate
Top: 1%, Bottom: 1%, Left: 0.756", Right: 0.75

Wide
Top: 1%, Bottom: 1%, Left: 2°, Right: 2 o
D Mirrored
Top: 1%, Bottom: 1", Left: 1.258% Right: 1"
Custom Margins...

1. Select the Layout tab.
2. Select Margins.

3. Click Custom Margins...
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Adjusting margins continued

Dacument
m Layout
| Top: | 1" z
Bottom: |1" z
Left: 1" -
Right: 1" z
Gutter: | Q" z

Gutter Position: | Left a

Pages

Mirror margins

(")

Apply to: = Whole document a \\

Default... Page Setup... Cancel -l_

1. Adjust margins as needed.

2. Select OK.

Created by Mallory

BYU-Idaho Online | GS107

Page 12



BYU-Idaho Online Knowledgebase

How Do | Copy And Paste Content And
Clear Source Formatting? (copied)

Below are instuctions on how to copy and paste content as well as clearing the source
formatting.

Copy the text from webpage

v 'j"f’ ‘ -~ ‘\‘...'-
o F. - —-—-___.\—__“ : &

Note: To save this image, right click on the image and choose 'save image as'. Pay attention to where

you save the image. o

Usithis for the content text in your flyer:
Wel e 1o a new and exciting year of sciencl leaming, and fun. This year we will be exploring the
worlds of biclogy and physics. During this class You will experience a broad range of topics dealing with
biology and physical science. While you will be hayn( _Look Up “V\;';Icc-lma io a-new a-nd a:tcl'ti;'wg yéarl:lf science,..”
technology in as a tool to complete many of the cl
your syllabus, you will be required to bring the followi

Search Google for “Welcome to a new and exciting year of science,..

the lab: Print...

Pencil Paper Calculator Ruler Inspect

Technology tools we will use this year: Microscopes, |  speech >
Spmadehoetn Add to iTunes as a Spoken Track

(If needed, the link to the data is http://www.byuiedtechlab.com/wrd-p-content.html)

1. To copy the text, highlight the text you want.

2. Next (while the text is highlighted), right click using your mouse or keypad and select "copy".

o

If the Mac doesn't give you the option to right click. Use the keyboard and hold down the
command key along with the C key to copy.
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Paste the content into Word

& Word File Edit View Insert Format Tools Table Window Help £} < L Thu11:30AM Allison, Mallory Q@

|
i

e | Paste Special... AV
4
Font... ®D

| Paragraph... M

Smart Lookup...  ~XC sel_ Biret wo are

I

|

i

|

i

|

| Hyperlink. LT
[icev/Comment Educational
Websites, Excel Spreadshieets

PageTof1 TaWords 07 English (US)

100N N aBBROBRFALT ORE) 9 dravis

3. Next go to the word document and right click again, this time selecting "paste".

€ Ifyou are using a Mac computer that doesn't give you the option to right click, using the
keyboard select the command key along with the v key to paste.
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Clear source formatting

Insert Design Layout References Mailings Review View

- TAa ] — —
i - +| A~ Aw - R e R = =R
U—1 T Arial 135 As Ar A3 C=ARE = ! == 24| AaBbCeDdEe || AaBbCeDdEe | |AaBbCcDe  AaBl
Paste B I U -abe X; X2 4 A - Bl = | = | = |[5=- & . bebed | v Normal Mo Spacing Heading 1 He
§ X : : i =

©
©

! licroscc ) ameras, Educational

dsheets

1. The first step is to select the home tab.
2. Next highlight the text.

3. Finally, click the icon shown above (it is an A with an eraser next to it).

€ Created by Mallory
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How Do | Edit Text?

Below are instructions on how to edit text within a word document.

Change the font style, size, and color

Insert Design  Layout References Mailings Review View

[Georgia - I~ JA- A~ A4 Ap| iZ]-i= |~ 'Tx|e=|o=||4s) T £aBbCcDdEe  AaBbCcDdEe
Past B, I U abe X

- 2 X3 v K v = = = = f=. G . . Normal Mo Spating Heading 1 Heading 2
< Y s

i I 1 ¢ 3

©

‘Welcome to a new and exciting year of science,
learning, and fun. This year we will be exploring
the worlds of biology and physics. During this
class you will experience a broad range of topics
___ dealing with biology and physical science. While
you will be having fun, you will also be learning
e,—-f and using technology in as a tool to complete
4 many of the class assignments. In additional to
the books listed in your syllabus, you will be
required to bring the following items to class any
day that we are meeting in the lab:
e Pencil
» Paper
o Calculator
» Ruler
Technology tools we will use this year:

(]

[ Microscopes | Digital Cameras |

Educational Websites Excel Spreadsheets

1. Select the home tab.

2. Highlight the text you want to change.

3. Select the font tab and choose which font to use.

4. Select the size tab and select which font size to use.

5. Select the color icon shown above. (It looks like an A with red line underneath)
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Created by Mallory
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How Do | Insert A Bulleted List And A
Table? (copied)

Below are instructions on how to insert a bulleted list and/or a table. There are also
instructions on how to edit the contents of the table.

Add 4 bullet items

Document]

Layout References Mailings Review View

e - Ap = A q
— ibri - - - Aw - = z
0 { Calibri {Body] 12 A Aa * i + AaBbCeDdEe  AaBbOcDdEe  AaBbCcDc
Paste B I U rabe X3 X LA & |r A - ] Hormal M Spasing Heading 1 Heading &

Welcome to a new and exciting year of science, learning, and
fun. This year we will be exploring the worlds of biology and
physics. During this class you will experience a broad range of
topics dealing with biclogy and physical science. While you will
be having fun, you will also be learning and using technalogy
in as a tool to complete many of the dass assignments. In

e additional to the books listed in your syllabus, you will be
required to bring the following items to class any day that we
are meeting in the lab:

+ [Pencil

= Paper

*  Calculator

*  Ruler
Technology tools we will use this year: Microscopes,
Digital Cameras, Educational Websites, Excel
Spreadsheets

1. Select the home tab.
2. Click into the word document at the spot you want your list to start.

3. Click the bullet icon shown above.
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€ After you select the bullet icon, whenever you press enter, it will create a new bullet.

Insert a 2X2 table

Design Layout References Mailings Review View

ol (-T2 gllg- Lggw  @owe w B @ P =
Cover nk Page it Screonshor S MyAdd-ins - Wikipedia  Modia rink &
Page Break D

—©
b4

= Insert Table...

= Draw Table
Welcome to a new and exciting year of science, learning, and
fun. This year we will be exploring the worlds of bislegy and
physics. During this class you will experience a broad range of
topics dealing with biclegy and physical science. While you will
be having fun, you will also be learning and using technology
in as a tool to complete many of the class assignments. In
additional to the books listed in your syllabus, you will be
required to bring the following items to class any day that we
are meeting in the lab:

= Pencil
= Paper
\ = Calculator
* Ruler
Technology tools we will use this year:
s
| Microscopes | Digital Cameras |

Educational Websites | Excel Spreadsheets |

1. Select the insert tab.
2. Select the table icon.
3. Choose the size of your table.

4. Insert the text you want into each section of the table.
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Add text to the table

+chlmalog}f tools we will use this year:

. Microscope Digital Cameras e—‘|
oﬁucafmnaf Wc! sites | Excel Spreadshectow®™
j —

1. Click into one of table cells.

2. Then you can begin typing or pasting the text you want inside.

Merging cells in a table

o
"

1. Highlight the cells you would like to merge.

BYU-Idaho Online | GS107
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Merging cells continued

Home Insert Design Layout References Mailings Review View Table Design

k Select~ o

= — T | 5 - 11l & o
) ) PR _-—x. FpE o (B — = =|« I weight: 0.4z -
View Gridlines . .
- . Draw Eraser Delete Insert Insert | & Merge — Astofit G5 Widgth: | 250" = = Alignr
Properties Table Above Below Cells

1. Select the Layout tab.

2. Click Merge Cells.
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How Do | Insert An Image Into Word?
(copied)

Below are instructions on how to save and insert an image from a website into a Word
Document.

Insert an image

Science Image

Open Image in NejTab
Save Image As...
Copy Image

Copy Image Address
Search Google for Image

Inspect
Note: To save this image, right click on the image and choose 'save image as

you save the image.

Add to iTunes as a Spoken Track

1. Right click on the image.

2. Select the option "Save Image As..."
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Saving image onto computer

@ www.byuiedtechlab.com/wrd-p-content.html

Save As: Science Image v

Tags:

<

Where: | | & Downloads

<

Format: JPEG image

Cancel Save

3. Choose what you want to save the image as to the computer.

4. Click the save button.
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Inserting image into document

m Insert Design Layout References Mailings Review View

i) s it D
- - ! - - N Chart v - -1 R4 3 - - - o -
o L3- 12 S 0 @ v OO0l 4
Pages able " Screenshot * Add-ins Media Links Comment Header Footer Page Text

|«Z| Photo Browser...

Number
[ —_— o 2 3 4 5 7 8 a
"9 Picture from File... 7 fa

[l

Welcome to a new and exciting year of science,
learning, and fun. This year we will be exploring
the worlds of biology and physics. During this
class you will experience a broad range of topics
dealing with biology and physical science. While
you will be having fun, you will also be learning
and using technology in as a tool to complete
many of the class assignments. In additional to
the books listed in your syllabus, you will be
reguired to bring the following items to class any
day that we are meeting in the lab:

* Pencil

s Paper

s Calculator

5. Select the insert tab.
6. Click on the pictures button.

7. Select the option "Picture from File...".
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Inserting image continued

BN > EE= @ EETRVS 8 Searching “This Mac” 2 ence image &
Favorites Search: “Downloads” Shared Save || +
E Al My Files

| 7 iCloud Drive

| #% Applications o
[ Desktop N

@ Documents
@) Downloads 200

" Science Image.jpg
Devices ‘\
e (o)

(@) Remote Disc \ !
- Mt

Shared
@ AlL.. @

Media

n Music

[ Photos

Options Cancel

8. Search for what you saved the image as.

9. Click on the saved image.
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Final image in document

to a new and exciting year of science,
ind fun. This year we will be exploring
; of biology and physics. During this
#ill experience a broad range of topics
th biology and physical science. While

2 having fun, you willgme be learning
technology inasa I@ SE .
1e class assignments

5th Grade Science

listed in vour syllabus, you will be

o bring the following items to class any

¢ are meeting in the lab:

Al

T
ulator
T

v tools we will use this year:

additional to

pes

Digital Cameras

nal Websites

Excel Spreadsheets

10. The image will appear in the word document.

€ Ifthe image needs to be moved, follow the directions below on how to "wrap text". (Wrap

text can work for text boxes and shapes as well)

€ Created by Mallory
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How Do | Move A Text Box Or A Picture?

(copied)

Below are instructions on how to wrap text. Wrapping the text allows a text box, shape, or
image to move freely within a Word Document.

How to wrap text

. /_ | Save as Picture...
Change Picture...
Group >
Bring to Front >
] Send to Back >
Hyperlink... K
Insert Caption...
e ﬁ Wrap Text >
ey
Size and Position...
Format Picture... {81 v
|
v

Ll

A In Line with Text

Square

Tight

= Through

~ Top and Bottom

[l 131 131

Il

Behind Text
In Front of Text

1~] Edit Wrap Boundary

Move with Text
Fix Position on Page

More Layout Options...

1. Right click on the image.

2. Select the "Wrap Text" option.

3. Choose the option "In Front of Text".

BYU-Idaho Online | GS107
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Created by Mallory
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How Do | Insert And Edit A Textbox?
(copied)

Below are instructions on how to insert and edit a textbox in a Word Document.

Insert a text box

e = Document]
Layout  References  Mailings  Review  View  Shape Format

. . [P T2 achen i stee E ; ; . . (B,
W wikipedia 3 &W L
Pages Table  Picwres Shapes SmartArt (g Screenshatt g My Addens - Media Links  Comment  Header Footer o
Nu

©

cee N w-

Home |[EEEES

Design

Equation Vang
& Draw Text Box : 5

: ’: Vertical Text Box

/ &% Grade Science
° nce, [Microscop [ Digital Camn |

Microscopes améras
| Educational Websites | Excel Spreadsbeets |

Wele

Pageiof1 ¥  English (US)

+ 9%

1. Click on the insert tab.

2. Select the text box tab.

3. Select the draw text box tab.

4. Click and drag mouse to create a text box the same size as shown in the example.

5. In the text box, type "5th Grade Science".
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Allow text box free movement

oee [ Tt ] Document

Home & Bsign References  Mailings ¢ Wiew Shape Format

L
- . » y
9 . . S, . . B All. = . Ol 7
A= |E] Abc Abc | p mmm M{EE ¥ i - H“ 0w ’ &
Shopos :p.: » shape  log v ToxiFil @ « Text amange | = 725t = [Format
\ef =] D = 1 _N Group

Position o \ e
/ In Line with Text \_/h s
o 1 r
T 5" Grade Seieneg -~ Sguare

o = Tight
-4

#x Thraugh
/ ; & Top and Bottom
o_mmlz to a new and exciting year of science, == Behind Text

ing, and fun. This vear we will be exploring
the warlds of biology and physies. During this
class you will experience a broad range of topics
dealing with bielogy and physical science. While
you will be having fun. you will alse be leaming
and using technology in as o tool to complete

-] Edit Wrap Boundary

=

many of the class assignments, In additional to + Move with Text °

the books listed in your syllabus, vou will be = e \ [
: 2 = Fix Position on Page

required 1o bring the following items 1o class any & \'I-l/‘

day that we are meeting in the lab: = _
LI More Layout Options...

Pencil
Paper
Calculator
Ruler

Q@  To allow the text box free movement without changing the margins, follow these steps
and refer to the example above:

1. Select the title text box.

2. Click on the shape format tab.
3. Select the arrange tab.

4. Select the wrap text tab.

5. Select the in front of text option.

BYU-Idaho Online | GS107 Page 30



BYU-Idaho Online Knowledgebase

Change the font of title

Eu - Documen

Layout References Mailings Review View

il
R s C3F
Paste 7 a8 = = :

;5“‘ Grade:_:Science

Welcome to a new and exciting vear of science,
learning, and fun. This vear we will be exploring
the worlds of biology and physics. During this
class vou will experience a broad range of topics
dealing with biology and physical science. While
you will be having fun, you will also be learning
and using technology in as a tool to complete
many of the class assignments. In additional to
the books listed in vour syllabus, vou will be
required to bring the following items to class any

1. Click on the home tab.

2. Select the color icon shown above. (It looks like an A with red line underneath)
3. Select the size tab and select which font size to use.

4. Select the font tab and choose which font to use.

5. Select the bold button.

€ Created by Emily H
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How Do | Get Rid Of The Outline Around
A Text Box?

Sometimes when inserting a text box, an outline will be visible. Below are instructions on how
to remove the outline around a text box.

Removing Outline

Home Insert Design Layout References Mailings Review View Shape Format

; . 33 » A : 112 Text Directio

s . Abc Abc b = A f'-l A \ » = = = | Align Toxt =
Shapes |A°| - Shape  [o 7 = | Text Fill /D) «

pos = e A & Create Link

1 Example

.g.l

1. Click in the text box.

2. Select the Shape Format tab.
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Removing Outline Continued

out References Mailings Review View Shape Format
T A\ A Text Direction »
ra A e “u
— A n *’.‘S: b - = Align Text *
f Text Fill v
L No Outline extFil A ¢ Create Link
Theme Colors -

L]

| T

Standard Colors

(| [ ]

& More Outline Colors...
= Weight [

Ha

[
—

1. Click on the shape outline icon (looks like a pencil and a square).

2. Click No Outline.

€ Created by Mallory
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How Do | Insert And Edit Shapes? (copied)

Below are instructions on how to insert, edit, and add text to shapes in a Word Document.

Insert two shapes

m Insert Design Layout References Mailings Review View

3 SR ke 8 B G ) D0 A

Pages Table Picture; — amment Header Footer Page Text
Recently Used Shapes Number

/ey "memal~ ; ’ ; g
Nl awa e
° NNSNTLL 2

Rectangles

]
Basic Shapes

E0 AL FAS
¢ o @01 L
EOOGON~NPOVW
o401 {03

Block Arrows
= & 1t § & ¢ $
S ouUunN ==
db B N

* Ruler

Technology tools we will use this year:

[ Microscopes | Digital Cameras |
Educational Websites | Excel Spreadsheets |

1. Select the insert tab.
2. Select the shapes icon.
3. Select whichever shape matches.

4. Right click and selct "wrap text" (following the instructions above) to move the shape infront of the
image.
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Change the fill color of shapes

1. Select the shape.

Layout  References  Mailings  Review  View

L)

Shape Format

Welcome to a new and exciting year of seience,
learning, and fun. This year we will be exploring
the worlds of biclogy and physics. During this
class you will experience a broad range of topics
dealing with biology and physical science. While
you will be having fun, you will also be learning
and using technology in as a tool to complete
many of the class assignments. In additional to
the books listed in your syllabus, you will be
required to bring the following items to class any
day that we are meeting in the lab:

e Pencil

s Paper

e Caleulator

* Ruler

Technology tools we will use this year:

[Microscopes [Digital Cameras

|
Tducational Websites | Excel Spreadsheets

2. Once the shape is selected, a "Shape Format" tab will appear. Select that tab.

3. Select the shape fillimage, and then select the color you want to fill the shape.

4, Select the icon shown above (looks like a pencil with a line underneath) to change the outline of

the shape.
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Add text to the shapes

5t Grade Science _ ¢

exciting year of science,
year we will be exploring
nd physics. During this

e a broad range of topics
d physical science. While
you will also be learning
1 as a tool to complete
nments. In additional to
: syllabus, you will be
llowing items to class any
g in the lab:

11 use this year:

| Digital Cameras |
[ Excel Spreadsheets |

Join the
Science Club!

1. Double click on the shape.

2. Start typing in the shape. (The typing line may not appear, but once you start typing the words will
appear)

Q If the text doesn't appear when you start typing, check to make sure the color of the text
isn't the same as the color of the shape.

Created by Mallory
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How Do | Insert A Hyperlink? (copied)

Hyperlinks are in text links that allow you to click on them and go to the linked website. Below
are instructions on how to insert a hyperlink.

Insert a hyperlink

5th Grade Science

Weleome to a new and exciting year of science,
learning, and fun. This year we will be exploring
the worlds of biology and physics. During this
class you will experience a broad range of topics
dealing with biology and physical science. While
you will be having fun, you will also be learning
and using technology in as a tool to complete
many of the class assignments. In additional to

the books listed in your syllabug Ccut

required to bring the fgddowing i
day that we are meetj in the i  CORY
s Pencil Paste
s Paper Paste Special... ~HV
. Calm_'o
s Ruler~a/ Font... #D
Paragraph... M
Technology tools we will use thi \/\
Smart Lookup... ANEL
[ Microscopes [Digita Synonyms >
| Educational Websites | Excel ]
Sei

New Comment

Search With Google
Add to iTunes as a Spoken Tra
°

1. Highight the word "syllabus" and right click on the mouse (or if using a mac, hold down the
command key along with the K key).

2. Select the Hyperlink option.
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Hyperlink continued

5t" Grade Science

Welcomt Text to Display: | syllabus ScreenTip...

learning,

the worly Web Page or File  This Document  Email Address

class you

dealing v Link to an existing file or web page.

you will |

and usin

many of

the book

required

day that
s Peg

a @
‘' N

* Ru

Address: | http://www.byuiedtechlab.com Select...

54

Technolg

Microsg Cancel 0K
Educati.

Science Club!

©

1. In the box that appears type the following in the address box: http://www.byuiedtechlab.com

2. Select the OK button.
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Hyperlink continued

Welcome to a new and exciting year of science,
learning, and fun. This year we will be exploring
the worlds of biclogy and physics. During this
class you will experience a broad range of topics
dealing with biology and physical science. While
vou will be having fun, yvou will also be learning
and using technology in as a tnal o comnlete !
many of the class assignments  htte:/fwww.byuiedtechlab.comy |

the books listed in your syllabus, you will be _d
required to bring the following items to class any
day that we are meeting in the lab:

- o

« Pencil ,

# Paper E £ 7
# Caleculator

« Ruler

Technology tools we will use this vear:

Microscopes Digital Cameras
Educational Websites | Excel Spreadsheets

€ This is what the hyperlink will look like afterward. It will be a different color and
underlined. You can check if it works properly by clicking on the word "syllabus" or
hovering mouse over the word to make this yellow box appear.

€ Created by Emily H
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How Do | Insert A Line Into Word?

Below are instructions on how to insert a line into a word document.

Inserting a line

Home Insert Design Layout References Mailings Review View

[ ' ' fim) I
- - - v - il Chart = v -1 R [m=rRd -
= ] L3 T - Mo S B @ U0

Pages Table Picture:

L

arrment Header
ecently Used Shapes

E\N\NEHOEALL=IC
PNA L ) %

©

Lines

NNTLTL2232AN07

gles

Basic ShaRs

=e@Lr7a0c00000
ecoe @O L/ +@8 S
HOO POV (&N
SRS B

Block Arrows

=» e 1t | &t s PN L1

1. Select the insert tab.
2. Click Shapes.

3. Select the line shape.
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Inserting a line continued

Le

1. Click and draw the line.

Adjusting the line

pme Insert Design Layout References Mailings Review View

s A
=i

Styles ’ Pane

1. Click on the shape.
2. Select the Shape Format tab.

3. Select the icon shown above.
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Adjusting the line continued

Z8 As- Bll- - ¢

Mo Cutline

| Theme Colors

[ [ ]

-l

Standard Colors

HE e

& More Outline Colors...

= Arrows >

1. Select the color.

2. Click Weight to adjust the thickness of the line.

Created by Mallory
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How Do | Add A Page Border?

Below are instuctions on how to add and edit a page border inside of a Word document.

Inserting a border

Home Insert Design Layout Refereances Mailings Review View

Aa T Trole | + = Paragraph Spocing - B .

1T . , BB Aa = 0 " 5]
—

Themes : == Colors  Fonte () Setas Defoult Watermark  Page , Page

Cologgll Borde g,

©

1. Select the design tab.

2. Click on the page border option.
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Selecting a border

Borders Shading

Setting: o Style: Preview
.

| —| Click on diagram below or use buttons to apply borders
None

Box T =
Shadow Color:
Automatic ~
3-D Width: -
o 12 point ——— & o
r Custom =" Art: \__A/

Apply to: | Whole document

<

[none)

Options...

Horizontal Line...

oCanceI - oK
-

1. Select the style you would like to use.
2. Adjust the width.
3. Make sure to select apply to Whole document.

4, Select OK.
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Applying border from edge of page

Borders and Shading o
w0
Borders [Wz=lsLR=0IGEIAN Shading
Setting: Style: Preview
] Click on diagram below or use buttons to apply berders
None |
Box
Shadow Color:
Automatic a
3-D Width:
12 point  —— a
g Custom
llllll Art: o
— Apply to: | Whole document
(none) T ] -
(2)
Harizontal Line... Cancel -O_

1. Open up the page border option.

2. Select Options.
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Edge of page border continued

Border and Shading Options

Margin
Top: |1pt S Left: 4pt Z
Bottom: |1pt > Right: 4 pt "

Measure frem + Margin
Edge of page

Options
Align pgg@graph borders and table edges with page border

Alwaygfdisplay in front

Si--dlnd footer
[/} '._o_md header
A~y
Preview

1. Select the Measure from option and change from Margin to Edge of page.

2. Select OK.

Created by Mallory
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How to Insert a Solid Line

Below are instructions on how to insert a line underneath a text

Insert a Horizontal Line

Acrobat

Ax

Calibri (Body) = 12 - A= i 2+ 1 AABLCDdEe | AaBbicBdEe  AaBhL

Paste B I M - X; x* Q-8 -A-

Homsl || MoSsacinn | tesdng1
— Bottom Border
T Top Border
I Left Border
| Right Border

. . Ne Berder

Be Safe - Bicycle Safé m ugordes

Jiways wear a helmet. Many bicyclists carry 8 mo 1]
o_—-——-’ minutes before dusk or 30 minutes ater sunrise, L Cutside Bordars ear

reflector. A tadlight, additional reflectars and refit  + Inside Borders dsitle.
Check the weather ferecast bedfore riding. Avoid i aders
and waterproof clathing are recommended forwt — Inside Horizontal Border  owsof

breaking distantes in slck conditians. Inspect you 5.
gears and brakes need 1o be in good working orge | 1110€ Vertical Border
Rules of the Road

Bicyclits have the same rights and responsibilltie: .
driver's license is not required 1o ride a bike, bi raffic
Lsws such as stapping st stop signs and traffic igh g
Lanes. Never ride against traffic. A high percentagy Hlists
going the wrong way. Stay to the right # you ares  _# Draw Table ina
canstant pasition in the [ane about three feet awi View Gridlines aeave
n and out of parked cars. Maintaining a presence ) it
reduce the chance that mator venicles will pull in Borders and Shading... Wpare

with motor vehicles, the safest place t ride your bicyele is in the middle of the lane. if

hazards can lead to seriows injuries, and even death. When you're about to cross an
intersection, maintain a direct path through the intersection. Don’t veer to the left or right
Practice locking over your shoulder, hehind yau for traffic. This simple but essential skill allaws "
¥au to mave safely left or right to avoid a hazard, change lanes, ar make a turn. Looking over
your shoulder makes drivers pay attention o you. Master this skill even if you have a mirror,
Communicate the direction you are turning with hand signals at least 100 fieet prior 1o a turn or
change in lanes. Traffic flows smoother when drivers predict what others will do based on
traffic laws, By fallowing traffic laws and being aware of your surraundings yaur bicycle rides
will be much safer.

Off-Street Bicycling

On multi-use paths, bicycles shauld yield 1o pedestrians, and do nat pass unless there Is room,
Slow down and call aut "on yaur left” or "an your right” before passing cyclists, skaters, runners
or walkers, Riging on the sidewalk i normally not safe because bicyclists move faster than
pedestrians and are hard to hear. Always yield to pedestrians when you are in their space, and
dismount if pedestrian traffic is high. Be alert where sidewalks cross alleys, drivewsays and
streets = look left, right and left again before proceeding.

Pagetof 2 540 Wards [ Englsh (US)

1. Place cursor at the beginning of the paragraph.
2. Click the drop down menu of the "Borders" icon
3. Select "Horizontal Line"

¢  Ifrequired, do the same process for all other titles.
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Created by Guillermo
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How to Insert a Page Break

Below are instructions on how to insert a page break in a Word Document.

Insert a Page Break to separate content.

Acrobat

Review

@ 4= W E GPF L 0 NDR EA4AD T

75 Date & Time

Bage @ Serosnshor S My Adsinc - Wiipais  Meda Uk Boskmak Croprelmencs  Commant  Wesdw  Footee  Page  Textlex Workn Diop L——
Broai Mumber Cao Coiect Symbol

Be Safe - Bicycle Safety Tips

Mailings

L Alwsys wear s helme

e maile phme

5 Ifsouride wmnmvsbﬂmd&ﬂmxu minutes afurm'mw yoashould have awhite headlight
and rear reflector. A taillight, additional reflectors. and reactive dlothing ca alsa make yo more
viible.
[

Aveid riding ther conditione. Fenders
farwet: . and b cspect of

‘Bieyckists have the same rights and respansiblities as any other driver of n vehicie.

While  driver's license {s mot sequired s ride a bike, bicyclins are required to hmandnm all traffle
L Y h d traftic light b

+ Never ride Aigh perrentzge af all car/ result from cyclisis
Balng the wrang way. Stay w the Figh I you are movisg slawer thes b i, malcesin
CORSTANE OSITIGE 10 1he [ANE Khout BT (et Eway Erom the cars o parked ca

+ Do notweave Imnd nukofnllkgﬂ(m ‘Maintainizg 3 preseace on the road wil help
dm!rueuw ce the chance that motor ehldns»\'unull in fromt of you.

the safest place to ride your
rght side

' hlmjuh inthe
!

mm-mnm Domt veer 10-the et o7 rign

e looking arer your. ﬂmnlrkr. behined you for traffic. This spie bat essential
skl\lal.lwx ¥0u 10 maove sadely lef o right to avold a hazard, change lases. or make a tam.
Loskin aver your shoukde  makes drivers pay attestion to you. Master this sidll even if ou bave
8 mirroe.

. o b mdunl.nmnmumwhr

in lames, Traic
bmedoﬂ(mmc . By follonetng rafic s asd ey n.maaywmnunmmwr e

I >treet Uu_\t_lll‘lL
/ 1 donnt Slow dows
xndra\l!u‘ “on your left” or “on your I'\PJH bedore passing cyclists, skaters. mnnmnrwall:!r! Ridmg an

the sidewalk is normally =0t band tn hear.
Alucwys pield 1o pedestriass when yom are in theer space, and dismount f pedestrias traffc = high. Be alers
whare cidewnlks croe alleys, deivewnys and ctreets — ook lett, Fipkt and lef agals hedoee proceading.

©

1. Place the cursor on the area you want to separate.
2. Select the "Insert" tab.
3. Click on the "Page Break" icon.

¥ Page break indicates where the content of one page ends and where the new page starts.
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How to Insert Rows and Columns in a

Table

Below are instructions on how to additional rows and columns in a Word table.

Insert a Row

Home Insert Design Layout References Mailings Review View  Acrobst  Table Design [ENCEd

A - = = ==

Seleci  View Progerties  Draw Eraser  Deieie | Insert
Gridlines Table

(3 )

Be S

5

=~

insert ® wes Merge Spit  Spit  Autofit
Above Below W Colls Colls  Table

] "
> L = .
d

afe - Bicycle Safety Tips

Always wear a helmel.
Many bicyelists carry & mobile phone for emergenc

1 vou ride 30 mimtes before dush or 30 minis afue sunris, vou should have a whitc headlight
and reas reflector. A taillight, additianal reflectoss and reflective clathing can ala o a more
wisible.

Chack e mesbr s s ing s o o s wendir o Dsden
cautious of

nmklnr,dkunmm slick conditi
Tnspect your icyel hefore a afte each ide — tres, gears and brakes need  be in good
‘warking order every time you ride.

Rules of the Road

Bicyclists have the same rights and respansibilitis o5 any ather driver of & vehicle

‘While.a driver's license s not required to ride a bike, bicyclists are required to know and obey all traffle
Iaws such 45 stopping at stop signs and traffic lights und signaling before turning or changing lanes.

. A i all car s eyelists
foing th wroag iy, Sy 1 the g you ¢ movin doverthan oherraffc, maorain &
constant position in the lane about three feet away from the curb or parke ca
Do not weave in and out of parked cars. Maintaining a presence on the mu illbelp
drm.-n.sn you amlwll mdm')u:dunm that mator vehicles will pull in front

narrow th motou-vehicles, the axfost place to rlde your
bicyele b i the middie of the lane. e Tanes hecome wider, move aver o e (gl st

aln safer right than
e Bere, s hding too fa 1 the right p..mn.qumngm ightines,
TeRing car doors 10 Grforeseen Yaay hisards can ad 1 serous Irmmus. and even death.

When you're abaut to cross an intersection, maintain & dircct path through the
intersection. Dont veer to the lef o right

for traffle. This simple but essential
skl allows you to move safely left or ight 1o avoid a hazard, change lanes, of make & turn,
Looking over your shoulder makes drivers pay atteation to you. Master this skill even if you have
amimos.

o

i i hand signals at |
aturn or change in lanes. Traffic flows smoother when drivers pradict what others will do
based on tufi v, By fllowing 223 s and belng aware of your surroundings your bicycle
rices will be much safer

| pistrisute Rews

[ Distributo Columns

\f—"

A= i A L =

= 0O 2+ 5= Jx

Text  Cell Sort peat  Converl Formula
Direction Margins Hong Rows o Tont

Off-Street Bicycling

On multi-use paths, bicycles should yicld ta pedestrians, and do not pass unless there ks roam. Slow down
and call oat “on your IeR” or "on your ght” before passing evclists, skators, ranors or wilkess. Riding on

Always yield to you are in their space, qunmmmnu Bealert
where sidewalks cross alleys, driveways and sirects — look lefl, right and Ieft again before proceeding.

Statistics

[1-Gear [333 287 [21 |
[3-Gear 311 | 451 [E3 |
515 Gear IR ES 22 ]

1. Select the first row.

2. Click the "Layout" tab.
3. Click on the "Insert Above" or "Insert Below" icon depending where you want the row to be

inserted.
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Insert a Column

. = - i Disrnute Rows B E Az & oa = 5 A
L3 ! - a2 O 74 o x
Select View  Properties Draw  Eraser Delete Lo W Split  Split AutoFit = wiath, 62" £ ™ Distribyte Columng Text Sort. Repeat  Convert Formula
Griviines Tavie ey Colls  Cells  Taie = Direction mm Hesdsr 30w 10 Tex:

o

Be Safe - Bicycle Safety Tips Off-Street Bicycling

L Always wear o helmet. On multi-use paths, bieyeles should yield to pedestrians, and do not pass unless there i roams. Slow down
2 Many bicyclists carry a mobile phone for emergencies ) 2d el outon our keff”or“onyour ekt befoe puing i, shates, runmersor walkr. i on
3 1you ride 30 minutes before dusk or 30 minutes ater sunrise, you should have a white beadlight the idevalcis nornaly na afs because bicylists e aer than pedetrans an are hard 0 o

and rear reflector. A taillight, additional reflectors and reflective clothing can also make you more Always yield you are in the i pedestrian trafic s high. Be sler

where sidewalks cross alleys, driveways and strcets — look left, right and left again before proceeding.

visible,
4. Check the weather forecast before riding. Avoid riding in extreme weather conditions. Fenders
are far et nd ¢ eautiaus of

breaking distances in slick conditions. - ickHire
yele before and after cach ride — tires, goars and brakes need to be in good Statistics

Inspect your b
working arder every time you ride. -
Rules of the Road e [EEE] Tas7 ER ]
[GGesr [ Tes1 [26 |
Bicyrlists have the same rights and responsibilities as any other driver of & vehicle. [5:15 Gear ['ss2 BT [z ]

Vile ives e s ot required o e bike, bieeliss are oquired 1o knove s by ol e
stwppi d signaling n of changing lancs.

traffic. A C from cyclists
ol vulhmmu way. Stay to the right if you are maving slower than n:hmnrﬁc maintain a
constant posiiion in the lane about thiree feet away from the carb or panm

+ Do not weave in and out of parked cars. Maintaining a presea ﬂwmdkﬂlhdu
driverssoe you an wil rduce the chance that motor velides il pull nfront ofyou.

. nes are tao narraw 1o share with motor vehicles, the tavide your
bicyele is in the middle of the lane, If the lan er, move over 1o the far xight.
again. Magy cclss belev they are safer and more comiorable riding farther o therighs than

suggested here, but riding 100 far to the right puts the cyelst in greater

IDEREn ca oies, b UAfoReseen Toadny Dazads can o ¥ serous njires, s vod e
Vhen you're about ta crass an intersection, maintain a direct path through the

tersection. Don't veer 1o the loft or right

 Practice looking aver your shoulder, behind you for traffic. This simple but essential

o right to avoid a hazard, change Lxnes, of make a turn.
o Lokdng v your ehoulder ik AFers pe atention 3 0. Saker this kil even i you huve
d miror.
- the dircction th band slgnals ot Least oo feet priar
wa “Traffic thers will do

Based on traffclavs. By following iaffic sws and being sware ofsour surroundings your bcycle
rides will be much safer.

1. Select a column.
2. Click the "Layout" tab.

3. Click on the "Insert Left" or "Insert Right" icon depending where you want the column to be
inserted.
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Delete a Row or a Column

. = 3 . E 3 = o1 1 | oistribute Rows

L 7 Ce I soa (] 9 i

Solect  View  Properties  Draw ort imsort  Merge Spit  Split AutoFit th: R162° - 7 pistribute Columns
Gridlines Table =* Delete Cells... i Right Colis  Colls Table

Delete Columns.
=5 Dalete Rows
« Delete Table

Be Safe - Bicycle Safety Tips

Always wear a helmet.

Many bicyclsts carry a mobile phone for emergencies.

ity ride o minutes beforedusk or 50 s atet s,y should hve s whie eadlgan
B, additional uake you more

we

4. Chock the weather forcast efore rilng. Avo rding n extremc weather condiions, Fenders
and waterproof elothing are recommended for wot weather rides, ¥nd be csposially cautious of
‘breaking distances in slick conditions.

Tnspect your bicycle before and ater éach rde — tres, gears and brakes need 10 be I good
working order every time you ride.

Rules of the Road

same rights and ofavehice.

@

Whilea driver' cense is not required o ridea bike, bicycliss mreqmredmkm» 2nd obey all raffic
laws such as stopping at ar changing lanes.

« Never ride against traffic. A high
going the wrong way. Stay to the right if you are moving slower than n.hrrhllﬁc maintain a
constant pesition in the lane about three feet away from the curb or

+ Do notweave inand out of parked.cars. Maiatiniog o prcscace  th soad wll elp

drivers sec you and will reduce the chance that motor vehicles will pull in front of you.

If lanes are too narrow to share with motor vehicles, the safest place to ride your

the ane. If the | ; movsaver ot e
again. Many safer and mo the right than

SEggsted hare, b Fding 100 fa 1 the AL u'ethe Yl in grester danger, Foor igitline

apening cas doors, and unforesecn roadway hazards can lead to serious injurics. and even death.

+  When you're abaut 10 cross an intersection, maintain a dircet path through the
intersection. Don' veer to the eft or right

Fractics looking aver your sheulder, behind yon for treffe. Thissimpl bt s

skill allows you to move safely left or right ta avoid a hazard, change

Looking ove sour showider makes drivers pay Renion o 5o Maste s skl evon i you v

amirror.

. you at least 100 feet prior
oa nge in lanes Traffc Artvers predict it e il o
e on traffic Laws. By of your your bicycle:
rides veill be much safer.

A A =
= LI 24 - .f X
Text  Col  Sort Convert Formula

v 10 Taxt

Off-Street Bicycling

nmult-ase pats, byl shouvild o podestians,and do nok pssunless thre i oo, S dov
an call out "on your e oF ‘on oir HEAT:before pasing eyelss,Heaters, runnecs o walkes, Riding an
the sdevalk s norally ot ale becanse bleyolts v i e padestrians and e b o e
h. Be alert
Took Ief, right anﬂmnmlnbmmpmudlw,

youare
vmm!ldtma'lkxem(unr,! driveways and stree

Statisti

&
[1-Gear 33 287 [21 ]

| EEY | Y [E3 |

[ 3-Gear
o/ls)sam | B8z | 546 |42 |

1. Select a Row or a Column.
2. Click the "Layout" tab.
3. Click the "Delete" icon, and choose the option you need.

¢  Rows are horizontal, and Columns are vertical.
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How to Add a Table Style

Below are instructions on how to add a table design to a current table on Word.

Use the Table Design Tab

Row | Firet Column B
Aow Last Colurn E=ces

V' Baneec Rows. Banged Calumas ===S

"

Be Safe - Bicycle Safety Tips
1. Always wear a heimet.
2. Many Mqﬂm carry a mobile phone for emergencies
3 dfsou

s should
. ector A gt iioval refectars e el B e s b 1w Te

2 mmm:umlzrrlmm before ridng. Al idh mmm-.nﬂmwnmum S—

brulklnxdbunm n sl
5 Inspect wu-hnmbdmam s cach e — s, gears and brakes need to be in good
‘warking order every time you ride.

Rules of the Road

Bicyelists have the same right as of a vehicle.

While a driver's iow and obey all traffic
Laws sach 25 stopping at mpihnsmdtumr \an\slndsi:mhlu bdmmmlm.ar changing lanes.

. w nnlm isions result from eyclists
going the wong way. 3 ou are T haa oder Gt i &
constam poskion mme hnelbeu\lhrw[nnwl! o mmrn or parked ca

[ s on theresd wil el
dmuute\nu i il i e duances i mmnleuul pull mfmmmw
‘share w place ta ride your

Bieyele 1 in the middie o the lane. e Illlesbocmnddnr mwmrmm! farsight side

again. Many cy .+ - and i farther to the rigkt
bt riding oo i
openiog;car dvors, apd unforesoen raodvay hazards can ead |nmiw$|muﬂ:s Al des

+  When you're about to cross an maintain a dire
intersection. Don't voer to the lef o7 right

+ Fractice lookin over vour shoukdes, behind you for trafic Tis simple but el
kil allows yo 1o mve cadely let o right 0 avoid a hazand, change lanes, o mike a
Lovking over voutshoulder makes ivers iy atention 1o Sou.Mastr s ol even  y0u have
amiror.

. the directi i at least 100 feet prior

a changs a lanoa.Trafc flows émoobuar when dvees prodict what cthirs il o
s o ews. B il ews i vare of s suroudings ot icyle
rides will be much safer.

a

&, —

Shading  Barser 2 point
Styles

Off-Street Bicycling

Pen  Borgers Baeser
Color Pairter

ok e bl sl ik e, s Sk g ket e, i drww

and call out “on your |

re.
the sidewalk Is normally not safe beri\m: bicyelists mave

ving i, Asdss, emmesscr el s, Xilag o
estrians and are hard

ster than
Nnmmmwmmmmnnwm o7 1 i Space, and lsmount 1 peSesiian a5 hl:h Bealert

Statistics

trests — 100k befs, right

A

Gear

1-Gear 333 287 21
3-Gear 311 431 26
5-15 Gear [ 545 a2

1. Select the table
2. Click on the "Table Design" tab.
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Choose a Table Style

' Hoader Row ¥/ Furst Colume

Totol Row Last Column ] L — &

Shaging  order Vipolt —— i Pen  Borders Gorcer
V| Banded Rows || Banded Columns. " =L Color Painter
0 3 3

Be Safe - E

Always wear a belr

Off-Street Bicycling

On multi-use paths, bicycles should yield to pedestrians, and do not pass unless there is room. Slow down

:. and call out "oa your left” or "on your right” before passing cydlists, skaters, runners or walkers. Riding on
3 the sidewalk i safe beca are hard 1o heas,
Alviys yeld to pedestrians when you are in their space, and dimount i pedestrian traffic i high. Be tlert
2 %, dris left, right and left again before procceding.
.
breaking distances - <
’ 5 o b Statistics
warking order evel =
Rules of tt
| 1-Gear 333 287 21
% Bicyclists have the same riy 3-Gear 311 481 26
5-15 Gear 882 546 42
‘While a driver's license is 1
laws such as stopping al st

+ Never ride agair
goin the wrang wi
constant position i
Do not weave in

drivers see you and

s are U
bicycle is in the

suggested lere, bu -

When yau're about intais

interseetion. Dant veerta the leftor right

+  Practice looking over your shoulder, behind you for traffic. This simple but esseatial

skill allows you to mave safely left or right to avoid a hazard, change lanes, or make a tumn.
o

ing over you hve
amirror.

+ Communicate the direction you are turning with hand signals st least 100 feet prior
10 aturn raffic flaws smouther i fict what others will do

d. laws. B laws and being awane i bicycle
rides will be much safer.

1. Click on the dropdown botton to display all table designs.
2. Click on the design of your choice.

€ Created by Guillermo S
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How to Recolor an Image

Below are instructions on how to recolor an image in a Word document.

Use the Picture Format Tab

Layout
- z sl |« J=k Gompross Picturos - . . [ act -
Yla ha)” |4 > > - 2 2 & = =
Remove ange  Corrections  Color  Ar: Transparoncy 7. Reset Pisture = — — = Send  Solection Align ) Retste Crop
Backgroun Picture & Sackward  Pano

Be Safe - Bicycle Safety Tips
L e sine, Off-Street Bicycling

z. :

ks ‘.L-‘;’L.r;é;": 'f”..m, i&é:fl‘n’.'\';"n'ﬂ"; P L gl g g Ol s, iyisshould ied o peestians, amd o ass s e s o Sl dowe
visible. and call out “on your left” or “on your right” before passing cyclists, skators, runners or walkers. Riding on

4. Check the weather forecast before riding. Avold riding in extreme weather conditions. Fenders the sidewall: is normally pot 1aft becase bl movefster than Mmﬂnmnwnehrdmw
nnd«mmmswhmgmnmmwm for wet weather rides, and be especially cautiaus of hen you are in the rian traffic is high. Be alert
Breaking distanees in slick conditi here sdwals cross lys,defeways and stvets  Iogelof, gt o e aga before proceeding.

“ 5 Inspect your birycle before and her each ide — tires, gears and brakes need to be in good
warking order every time you ride.

Rules of the Road Statistics

Bicyeliss b " i F————— Respondents
EEE)
Wil drvur' lioons s ot requied 1o ik, iyeists ar required 1o know nd ey ll atic n
Inws such as stopping at o ing lancs
882
+ Never ride against traffie. A high percentage of all car/bike eollisians result from eyelists e
£0Ing the wrong way. Stay to the right If you are moving slower than other traffic, maintan a
hres fect awa s,
+ Do not weave in and out of parked cars. Mainiaining a presence on the road will help
drivors see you and vill reduce the chance that motor vehicles will pull in front of you

safest place to the midele of the
e, I the lanes become wider, move over g he
sgain. Many s beere iy are st ad o o frable

nes are oo nlmhshlulﬂhmnhr\thinll&ﬂ: ?

Ilrﬂ\r“ﬂl\wlsimmdulmsmrdnnur Poor sll)“llms
openiny car doors, and unforeseen roadway harards ca
serious injuries, st even death
+ When you're about ta cross an intersection,
malntain g dircet path through the intersection. Dont 1.
veer to the lef o
. Pr:nimlnalﬂﬂi. over your shoulder, behind you for traffie. This simpie but essentlal
kil allows you to move safely let or right to avoid a hazard, change lanes, or make a turn.

Louking over your shoulder pay 0 you. Marter you have
& micor

. least 100 feet prior
o4 arm o change n fanes. Traf ows mmmmmmm peict vt sl do
Based on traffc laws, B your birycle

ride will be much safer.

1. Click on the image you want to recolor.
2. Click on the "Picture Format" tab.
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Recoloring Images

] -
L] Gl
Remose  Change
Background Picture
B

B BB E SR i~ g

Picture  Pictuse Position Wrap  Bring Sens  Seleetion Align  *|, Rotate v Crop.
Berser  Effects Tea  Forwars Sackword  Pane :

X 7 3 H [ 7

Off-Street Bicycling

Ju should have 2 white headlight
ing can also make you more mmsﬂnu:pmlls hicycles should yield to pedestrians, and do not pass unless there is room. Slow down.
gl ot o sous L on "o your g bt pssing s, saters, runners o valker. Ridiag on
th di Fen m sidewalk is normal nd rd to heas
mu;:::;ummm Always yield ke W pedestrian taffc s igh. Bealert

where sidemale croms lleys, debveveys andstreets ook I, ight and I again beders procecding
rakes need to be in good

‘___e Statistics

velicle. Gear Respandents Annual Mileage Accident/Year
— 1Gear 333 287 u

1o know &nd obey all waffic
Furning ar changing lanes. 3Gear 311 291 %

515 Gear 882 546 a2
llisions result from cyclists
Jun cther teaffe, maintain a

porked cars.
= ssence an the road will help

# Set Transparent Color ﬁpu‘!mfmmdrm-

%7 Picture Colar Options... L
nuu-; mnwmmwp n!wwdhm bt riding too far
tothe right puts the rydmmymmdnmr Foor sightlines,
opening car doars, and unforeseen hazards can lead to

death.

« When you're about to cross an intersection, L
= maintain a direct path through the intersection. DORY 1,0 e 1 Alwave wear & helment
wtotekllorrgn

. ur behind you for traffic.
m.m,mmmmnu,-u.n o sight 1o 1v0id o hacard, change lanes, o make e
¥ drivers pay 10 yons. Master this skill even if you have
amira.
. hand slgnals at least 100 foet prior

hased on radh v, B lomog waths vt 0 b sars o you srtoudigs o bele
rides will be much sa

1. Click on the "Color" icon.
2. Select a recolor style from the options.

€ Created by Guillermo S
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How Do | Copy And Paste Content Into
Excel? (copied)

Copy the Content From the Webpage

Below are instructions on how to copy and paste content from a webpage into Excel.

Spreadsheet Data: Copy and paste this table into Excel by clicking and dragging in betwes
arrows to ensure that the entire table is selected. Then right-click and choose copy.

me typically has less issues copying this content

Start dragging hera —>

Classmom Budget
Date H=m Quantty itemdCost Toinil Cost Pey
004 Penclls 115
Search Google for “Classroom Budget $4,000.00 Starting Balance Date.."
1004 Pers fir g Print-
‘ Inspect
V122004 Scissor a5 51
* Speech >
(EEEET B 5 g AddtolTunes as a Spoken Track

(If needed, the link to the webpage is http://www.byuiedtechlab.com/exl-p-content.html)
1. Follow the directions on the page and click and drag until all of the data is highlighted.

2. Right click and select copy (or use "Command C" on Mac and "Ctrl + C" on Windows).

Make sure you are using Google Chrome. We have found that the content transfers over
best when Google Chrome is used.
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Paste the Content From the Webpage to Cell A1

Home

u—: v

Paste

Al

=B R R TR TR

)

Insert Page Layout Formulas Data Review View
X cu Calibri(Body) +|[12 + A~ A» = = _| &~
L1 Copy "Q\
o v J v A~ = = = &= 8=
<% Format B I Y — = = = EE
'y
D E F G H

Cut E G

Copy 8C |

Paste 8V e
| Paste Special... ~BV | f

Insert...
Delete...
Clear Contents

v

Filter

Sort >
Insert Comment

Format Cells... 81 |
Pick From Drop-down List... |
Define Name... |
Hyperlink... BK

1. Right click in cell A1 (or use the keyboard, selecting the command key and the v key).

3. Select the the paste option.

Created by Mallory
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How Do | Format The Data In A
Spreadsheet? (copied)

Below is instructions on how to format data in a spreadsheet. Formatting options include font,
merge and center, and backgrounds.

Format the data (A1-F19) to Courier New 10 pt. black

Insert Page Layout Formulas Data T View

4% G Ye)a- s = =Ee
Copy ~ 4
Paste B I U \ T = = = |€= =
% Format i —
Al . fix  Classrog
A B c E G H
1 :_’ssr:c:.'. Budget o ’ ‘
2 1 I
3 o vo $4,000.00 s:ar:'_.'h\eggr::e
4 \"-r/ U
5 |oaze Item Quantity Item/Cost |Total Cost |[Percentage of Total Bplance
6 10/10/04 | Pencils 115 §0.62
7 10/11/04 |Pens 117 §0.55
8 10/12/04 |Scissors 45 $1.20
9 10/13/04|Glue a7 §2.25 o
10| 10/14/04|Paper a5 36.20 w
11 10/15/04 |Markers 62 $3.45
12 10/16/04 |Text Books 45 527.90
13 10/17/04 |Card Stock 32 §2.80
14 10/18/04 Paper Clipd 36 50.52
15 10/19/04 |Crayons 49 50.89
16 10/20/04 | Tape 73 $1.50
17 Total coat
18
19 Ending Balance
20
21
22

1. Select the home tab.

2. Highlight all of the data from A1-F19.

3. Select which font you want to use, using the icon shown above.
4. Select the size you want to use.

5. Change the color of the font by selecting the icon shown above. (An A with a line underneath).
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Format the text in Row 1 to Courier New 16 pt. purple,
bold

Home Insert Page Layout Formulas Data Review View
a Y cut

Courier New A= Aw R Sp)

Il
2%

Copy =
Pafte

>
Il
1]
Il
«x*
|
&
Il

% Format

S4,000. LLe"ng’ Balance

ate Item Total Cost 721’ entage of Total Balance

10/10/04 Pencils 115 s0.82
10/11/04 Pens 117 50.55
e 10/12/04 | Scissors 45 §1.20
\1?"/( 10/13/04 | Glue 37 §2.25
10 10/14/04 Paper a5 56.20
11 10/15/04 Markers 62 53.45
12 10/16/04 | Text Books 45 $27.90
13 10/17/04|Card Stock 32 §2.80
14 10/18/04 Paper Clip: 38 50.52
15 10/19/04 Cravons 49 50.89
16 10/20/04 Tape 73 $1.50
17 Total coat
18
19 Ending Balance

1. Select the home tab.

2. Click into cell A1.

3. Select the size you want to use, using the icon shown above.
4. Select the bold button.

5. Change the color of the font by selecting the icon shown above. (An A with a line underneath).
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Merge and center the text in Row 1 across columns A-F

oe® M Hwowvo-J Workbook‘l@

Insert Page Layout Formulas Data Review View

Courier New =16 - As A~

B|I Y - A =

fx Classroom Budget
Merge Across

£ Merge Cells
0 Unmerge Cells  {

B C D E F G H
Classroom Budget

54,000.00 Starting Balance

Total Cost |Percentage of Total Balance

1. Select the home tab.
2. Highlight the data from A1-F1.
3. Select the merge and center drop-down box.

4. Select the merge and center option.
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Format the headings in Row 5 to Courier New 12 pt.
black, italic, centered.

M E v~ o
Insert Page Layout Formulas
1
2
3 1 54,000.00 |Starting Balance
4
5| Date ITtem Quantity Ttem/Cost| Cost Pere of 'TatalI Balance
] 14310/04|Pencils 115 50.62
7 11/04 Pens 117 50.55
] 45 §1.20
g 37 §2.25
85 $6.20
62 $3.45
45 §527.90
32 SEZ.80
34 $0.52
2 v 44 50.89
16 10/20/04 | Tape 73 51.50
17 Total cost
18
19 Ending Balance
20
21

1. Select the home tab.

2. Highlight the data from A5-F5.

3. Select the italic button.

4, Select which font you want to use, using the icon shown above.
5. Select the size you want to use, using the icon shown above.

6. Select the center text button.
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Add a light yellow cell background to the headings in

Row 5.

MAEdw-J

Insert  Page Layout

-

Courier New 12

-

Paste ¢$? B I (MU ~ |~

AS : fx Date
A B C

1 ClassroorIBw
3 !
e A4
4
5| Date Ttem  Quantity Item/C
6 10/1§4/04 Pencils 115 50|
7 U4 Pens 117 50,
8 10402/04 | Scissors 45 51
9 1g13/04 | Glue a7 52|
10 /14/04|Paper a5 EL
11 0/15/04 Markers a2 53
] C0/16/04 Text Books 45 527
o 0/17/04|Card Stock iz 52,
Mw;a;ue Paper Clip a8 50
15 10/19/04 Crayons 48 50
16 10/20/04 | Tape 73 51
17
18
19
20
21

Formulas

D Theme Colors

Data Review View

No Fill

B EEEECEE |

T

. Standard Colors

EED DEEEEE

& More Qplors...

o

cost

.52
AL
.50

Ending Balance

1. Highlight the data from A5-F5.

2. Select the fill color button, using the icon shown above.

3. Select the color you want to use.

o

The color does not have to be the exact shade of light yellow shown in the example

above. It should, however, look as close to the final excel project as possible.

o

Created by Emily H
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How Do | Adjust The Column Width?
(copied)

These are instructions on how to adjust column width in a spreadsheet.

Adjust the column width to fit the data.

® M A - = Workbook1
Home Insert Page Layout Formulas Data Review View
If\ - 3{’ . Courier New v 12 v As Aw =|= : o = Wrap Text Gene
Paste V;( B T U v i & . & v = E = €= = ++| Merge & Center v $ v
AS . fx Date
A B B D E F

G
f f f lesroom Budgetf f
S4,0nNg00 Starting Balance

1

2

3

: ©-.0 .0 (5)

5 P\_(é u Quu_v Ite\__ldt Total Cost Pé\___,ém Percentage of Total Me_l
6

7

8

10/10/04| Pencils 115 S0.82
10/11/0

ens 117 F0.55

51.20

ED §2.25
85 §6.20
62 §3.45

S27.30
32 52.80
EL 50.52

s0.83
73 $1.50

Total cost

Ending Balance

1. Double click in between A and B as shown above.
2. Double click in between B and C as shown above.
3. Double click in between C and D as shown above.
4. Double click in between D and E as shown above.
5. Double click in between E and F as shown above.

6. Double click in between F and G as shown above.
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Created by Emily H
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How To Change The Format Of Dates?
(copied)

Below are instructions on how to change the format of dates in Excel.

Format the dates in the cells in Column 1 to show day
and month.

MEdwvw o Workbook1

Insert Page Layout Formulas Data Review View

=" Cut N —
u—: X cu Courier New |10 ~+| A~ A~ = = | - =7 Wrap Text F. |
I I 2
3 Copy ™ &
Paste ¢ B I U~ & . AL = = = €= 9= ++| Merge & Center v Aec Lbenera 1al Forn
< Format = L 123 Ng specific format ng asT:
A6 . fc 10/10/2004 123 §8u2Tab:J
Ao B c D E F G | = Currency L K
1 4 Classroom Budget RO
2 | _= Accounting |
3 §4,000.00 |Starting Balance $38,270.00
4 m Short Date
5 Date Item Quantity Item/Cost Total Cost Per Item Percentage of Total Balance | 10/10/04
6 | 10/10/04|encid 115 50062 Long Date
7 | 20/12/04]zen 50.55 Sunday, October 10, 2004
B | 10/22/04|5ciss0 4 51.20 | @ Time
9 | 10/23/04|gu 37 $2.25 | 12:00:00 AM
10| 10/14/04]7 85 §6.20 | Percentage
11| 10/15/04 62 $3.45 | 3827000.00%
12 | 10/16/04|Tex: $27.90 | 1/ Fraction
13| 10/17/04|ca 3z 52.80 | 2 38970
14 | 10/18/0 36 1. 52 . -
10/28/08 = f 102 Scientific
15| 10/19/04 49 50.89 3.83E+04
16 | 10/20/04lTap 73 $1.50
17 s ABC gg:;a
18
19 Ending Balance
= | More Number Formats... |
21

1. Select the home tab.
2. Highlight the data from A6-A16.
3. Select the number format drop-down box as shown above.

4. Select the more number formats option at the bottom.
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Format the dates cont.

Format Cells

Alignment  Font Border Fill  Protection
- | Cat . Sample
: eneral
|\9/ Number 10-Oct
| Currency
Accounting Type:
Date *3/14/15
Time *Saturday, March 14, 2015
Percentage 3na
Fraction 3114/15
Scientific e 03/14/15
Text \__/
Special 14-Mar-15
Custom 14-Mar-15

= Location (Language):

United States (English)

Calendar type: o |
S

Gregorian H a

Date formats with an asterisk (*) are based on regional date and time sefpgs in
System Preferences>Language & Text.

1. Select the number button.
2. Select the date option.
3. When this box appears, select the date format you want to use.

4. Click the OK button.

Created by Emily H
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How Do | Complete Formulas And
Functions? (copied)

Below are instructions on how to enter formulas and functions into an excel spreadsheet.

In cell E6 write your own formula for the total cost of
pencils

: - Mo .

Classroom Budge®—

4,000.00 |Starting Balance

Item Quantity Item/Cost Total Cost Per Item Percentage of Total Balar

ancils | 1150 $0.62 |=cas |

W\

Ta coat

=ns
zissors
lue
Iper
arkers

Ending Balance

1. Click into cell E6.

2. Start a formula (or function) by inserting an equal sign (=).

3. Click (or type) what cell you want to use in the equation. To find the cost of pencils click cell C6.
4. To multipy the numbers in two different cells, insert an asterisk (*).

5. Click (or type) the cell you want to muliply. To find the cost of pencils click cell Dé.
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6. Once your equation is complete, press enter. You can see the equation you entered in the box

shown above.

Apply to all items

6 - fx =C6*D6
A B C D
|
I
i | Date Item

Quantity Item/Cost

P 115 50.62
f 117 50.55
b 45 51.20
] 37 52.25
1] 85 56.20
1 62 53.45
2 45 527.90
3 32 52.80
4 38 50.52
5 49 50.89
B 73 51.50
7
B
9
i}
L]

E F

Classroom Budget
g4,000.00 E:Er:'.r:g Balance

Tatal Cost Per Item Percentage of Total

S71.30
564.135
554.00
583.2

Ending Eo

(

1. Click on the green square in the corner.

2. Drag the square as far down as needed.
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In cell E17 use the Sum function to add the dollar

amounts in Column E

GE ) 4 fx =SUM(E6:E16)
8 B C D E
Classroom Budget
$4,000.00
te Item Quantity

t|Fens o 7 .
t|5cissors UW
t|Glue a7 52925

o T e I T o T e T o IO e I DR IO e IO o |
r': n n rn n n n n n rn n
1
=
H
Eal
11
H
m

t|Paper Clips
t|Crayons
T Tape

fis]

i3
/ S (E

Star

Item/Cast Tatal Cost Per Item Pern
[ [

50.62
50.55

56.20
$3.45
S27.380
S2.4d0
s0.352

$71.
Sa4.
¥a4.

]
35
oo

SH3.£3

332700

o' “o

=]
U
(i

Endi

1. Click into cell E17.

2. Insert an equal sign (=).

3. To use a function, start typing SUM after the equal sign.

4, Click and drag for whatever cells you want to use in the function.
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In cell E19, calculate the ending balance based on the
starting balance of $4,000

Home Insert Page Layout Formulas Data Review View

o
Paste

SUM v X v fx =E3E17
A B = D E
Classroom Budget

oﬁ 1 54,000.00 lstarting Balance

Quantity ITtem/Cost Total Cost Per ITtem Percentage of

115 50.682 571.30
117 50.55 564.35
45 F1.20 F34.00
37 §2.25 583.25
a5 56.20 F227.00
a2 53.45 5213.490
a5 $27.90 $1,255.50
3z 52.80 589.a80
EL] S0.52 518.72

1% t avon 49 50.89 543.481

20-0ct | Tape 51 450 5109.50
't n
i 52,530.73 Total cosc
5 il

IEn:l'_r: Balance
H g

D—AD'\ﬂmﬂmmbwub—nD‘“w"*m”""‘wNH

1. Click into cell E19 and enter an equal sign (=).
2. Start your equation with $4,000 by clicking into cell E2.
3. Enter a subtraction sign (-).

4, Select E17 and click enter to find the ending balance.
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Change the text to green, bold

I Home
ol

Paste

E19

Date

(1= - "I - ¥ R S PU R

e e
N m bk WM e S

18

20
21
22

14-0ct

Insert  Page Layout
X Courier New ’
\}' ﬂ I U

: fe =E3-E17

m

C

10

Formulas Data

Review View
A+ Av ahla=— : o =9 Wrag
= = = | = 8=
E F
Claskroom Budget
54,000.00 |Starting Balance
1

Item — Quantity Item/Cost

10-0ct|Pencils 1

12-0ct|Scissors

13-0ct|Glue

Faper

15-0Oct |Markers
16-0ct|Text Books
17-0ct |Card Stock
18-0ct |Faper Clips
19-0ct |Crayons

20-0ct | Tape

15

11-0ct | Fens 117

45
17
a5
62
45
3z
kL
49

73

F0.

0
51
52
1]
53
527
52
0
50
51

82

.55
=20
.25
J20
-45
=90
.80
.52
-89
<530

15 Q |

Tota ést

Per Item Percentage of Tot

F71.

S64.

5213,
51,255,
S89.&
518.7
5413.
5109,
52,530.7

30
35

§1,469.

IEni:nq Balance

1. Click into cell E19.

2. Select the icon shown above to change the font color.

3. Select the icon shown above to bold the font.
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In cell F6 write your own formula to show the
percentage of the starting total balance for the total
cost of pencils (the percentage $71.30 is of the original
$4,000)

Home Insert Page Layout Formulas Data Review View

o
Paste

SUM L% W fx =EG/$ESE
A B C D E F G

Classroom Budget o
[_ Sé,LELELE.lElE}:ar:'_r::; Balance
1 Quantity Item/Cost Total Cost Per Item Percentage of Tj Balance
oﬁl 571.30 l=£&/5e5¢ |
'\\_/r 117 §0.33 §64.35
45 $1.20 $342.00
a7 §52.25
§6.20
53.45
1 Text Books 45 §27.90 1
17-0ct Stock 3z 52.80 9.a80
14 | 18-per|Paper Clips el 50.52 18.7:
15 | 19-Oct|Crayons EE] 50.89 o 543.81 o
16 | 20-occt|Tape 73 51.50 N 510850 e
17 $2,530.73 |Total cost
18
19 §1,469.27 Ending Balance
20
1
22

1. Click into cell F6 and enter an equal sign (=).
2. Click into cell E6.
3. Insert a slash symbol (/) to represent division.

4. Insert cell E3.

€ Notice in the image that | entered money signs into the equation. If you want to keep a
specific cell in the equation the same even when you apply it to other cells, entering the
money sign allows you to do so. Enter ($) then the column letter, then ($) and the row
number.
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Apply to all rows

$4,000.00 |Starting Balance

=m Quantity Item/Cost Total Cost Per Item Percentage of Total Balance
115 50.82 271.30 0.02
117 50.55 $64.35 $0.02

= 45 $1.20 $54.00 $0.01
37 9£.25 283.45 50.02
a5 56.20 5527.00 50.1
a2 $3.45 5213.90

ks 45 527.90 30

ock 32 e A0 589.60

1ips el o 218.7¢2

1 49 Rl 54381
73 51.50 5109.50

9£,330.731 |Total coat

§1,46%.27 Ending Balance o
M’

(Make sure to use the information in the blue box above. Otherwise the information in cell E3 will
have to be entered into every equation.)

1. Click on the small, greeen square in the corner.

2. Drag the square down as long as needed.

¢  Keepin mind that formulas and functions are different. If it specifies to use a formula, use
your own equation to get the desired result. Functions are formulas already built into
excel (such as SUM and AVG).

Created by Mallory
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How Do | Change Data And Decimal
Places? (copied)

Changing Cell Data to be Percentages

Below are instructions on how to edit cell data to show percentages, as well as how to format

decimal percision.

Insert Page Layout Formulas Data Review View

L) .

=T X Courier New =10 = A~ A= = = _ | &~ =T Wrap Text .- x Fx
L L - e
Faste B I = - | . & - = = #= ++ Merge & Center = aec General &l Format

M AEwon- G @] TCA Powerpaint Practice

u E = = = = L
- - — 123wy specific format fg as Table
F6 : fx =E6/SES3 123 Number
A B £ L E ¢ - Currency K
- $0.02

Classroom Budget
_=| Accounting
& s002

54,000.00 Starting Balarncae

FShDrt Date
Quantity Ttem/Cost Tota Par Tham Percentage of Total Balance Vo/o0
30 [ 50.02 | EOHQ Date -
i 50.02 Saturday, January 0, 1900
..... g 50.01 Time
£y $2.23 F¥81.25 F0.02 @ 12:25:40 AM
& $6.20 352 $0.13
] $3.43 213 50,05
527.30 5 50.3 1 Fraction
3z 5280 S0.02 2 o
= HLs A 10 Scientific
49 $0.89 $0.0 LTRE-07
$1.50 H0.03 Text
7 —— Al J
2, 2 [ "% oomezs e
19 §1,4€9.27 Ending Balance M M bar F
10 ore Number Formats...
1 i I T
17

1. Highlight the data you want to change.
2. Select the box shown above.

3. Select Percentage.
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Adding or Removing Decimal Precision

10 A= A = | = = = Wrap Text Percentage
i : A = = = #= &= Merge & Center %
3ES3
D E F

Classroom Budget

54,000.00 |Starting Balance

Ttam/Cost Total Cost Per Ttem Percentage of Total Balance
s0.e2 $71.30 1.78%
20.35 e4.35 1.61%
21 20 234.00 1.35%
o_—ii.' 2.08%
-\h__,.! $327.00 13.18%
23.45 $213.30 5.35%
F27.20 21,2535.50 31.39%
2.80 F82.80 2.24%
a0.52 S18.72 0.47%
a0.8%9 43.61 1.09%

I §1.530 S109.50 2.74%

§2,530.731 |Total cost

51,469.27 |Ending Balance

1. Highlight whatever data you want to change.
2. Select this icon to add more digits after the decimal point.

3. Select this icon to remove digits after the decimal point.

Created by Mallory
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How Do | Add Borders On Excel? (copied)

Open the Borders Menu

Below are instructions on how to add or edit borders on an excel spreadsheet.

CourlerNew | -|[12 |~||dajAr = = ||| & =T@ Wrap Text
- h 8 £ - [D [EXC i . = — L= ** Merge & Center -
- Fs

A - B c ! Bottom Border r .
Top Border
| Left Border

| Right Border g Balarce

Mo Border tentage of Total 3a:.-l1.1-7-e|

BH All Borders

|:| QOutside Borders
[C] Thick Box Border

__ Bottom Double Border

i Thick Bottom Border KT
 Top and Bottom Border 1044
Top and Thick Bottom Border

: Top and Double Bottom Border
1g Balanc

T Draw Border

E¥ Draw Border Grid
[# Erase Border

£ Line Color > e

Line Style >

. More Borders...

1. Highlight the cells you want to border.
2. Select the down arrow on the border icon shown above.

3. Select "More Borders..." option at the bottom of list.
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Edit the Borders

Date

Mumber  Alignment Font Fill oﬂlectir'
Line Style: Presets: - \.9/

wmtdt)
1 None emremenmeee | |:| |

| T None Outline Inside

Text Text

Line Color:

Automatic -

21 [~

Click a line style and color, and then click a preset border pattern or individual border
buttons. You can also apply borders by clicking in the preview box.

Conce

1. Select the type of line you want to use.
2. Click on the outline button.
3. Click on the inside button.

4. Select OK.

Created by Mallory
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How Do | Create A Graph In Excel?
(copied)

Below are instructions on how to create and edit a chart in excel.

Using the items in B5:B16 and the data in E5:E16, create
a 3D bar chart and place it under the data

Chart De=ign Format

= o= Brriartart . Sone Birsg Maps
p; |

o
" 1 - »
v i Aecormmardid Pzlures  Shages o Soreenshat v Wy &3C-ins Pocple Graph Fecemeanded s
aianl Tabilen o - a E Gharts 2
Chart1 & h—t | I
A 5 ¢ [ P H

e acioss S 10I% Siecked Har
] ELN

4

5 | Py P ] = .
= - =
7 | 11-Oct|Pwo

i 21 pmnTe

g 3.0 Chisl B B i 10K & L
10

i

12 2, F35. 50

1

14

15

i5 et

17

kL]

13 BL,489.27 Ezding

i2

3 ot Cost Per e
- o

3 e —
= -t Cimors
= [—
7 [
w ) Tewis
15 [ —

4 gy —
=i quy
n i -
32 ¥ =

13 Fesc
34 C 1 £m L]

1
35

1. Select the insert tab.

2. Highlight data from (B5:B16).

3. While holding down the command key (Mac) or control key (PC), highlight data from (E5:E16).
4. Select the chart icon shown above.

5. Select the 3-D Clustered Bar graph.
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In the bar chart, add data labels to show the dollar
amount for each item

Home Insert Page Layout Formulas Data Review View Chart Design Format

L) ———

I Axes [ 2

b Axis Titles >
| T Chart Title > i f

o E e — — G t
vs Data Labels L3 Y 4 FTi.36 1,788
II' None Bi4.3 1.61%

| & Data Jeble 3 B s
| . B3.2% Z.04%
{ More Data Label Options... — ° La s
1 i Gridliges Lty RN $211.90 - 5.15%
1 I Lege [ 327.90 31,255, 50
1 g 52,80 SR, &L 2.24%
1 e /i <13 §0.52 §18.72 0.4
1 49 s0.89 §431.61 1.09%
1 $1.50 104 0
1 32,530
18
19 §1,469.27 Ending Balance ‘
2 f\/
2:,[ Total Cost Per Item
22
3
4 rape D £ 305 50
25
26 L] _FTT
Fa Paper Cligs [ P
2 swce (T 589,60
29
I T e ——————————————
:3 viarkors T :::).% et fet P e
2
EEY rpe T ;- o

1. Click on the graph.

2. Select the Chart Design tab.

3. Select the option to Add Chart Element.

4. Select Data Labels option.

5. Select the "More Data Label Options..."
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Add a Legend to the Right of the Chart

coee M A wo-

Home Insert Page Layout Formulas Data Review View

18 § 1.09%
26-octlTape 73 1.580 109.50 2.74%
L E: '] _—
19 $1,468.27 Endirg Balance o,
20

2 //
2
Total Cost Per Item

1. Click on the graph.
2. Select the Chart Design tab.
3. Select the Quick Layout option.

4, Select the option that shows the legend on the right of the chart.
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Change All of the Text in the Chart to Arial.

Home Insert Page Layout Formulas Data Review View Chart Design
¥
10 A=~ Av
' 4 A
-
Chart.o,‘
A B F
B | 12-oct|Scissors 45 §54.00
9 a1 $83.25
10 Paper a5 $527.00
11 Markers &2 §213.90
12 45 §1,255.50
13| 1 c EH 58960
14 Paper Clips 38 518.72
15| 1 Crayons 49 543,61
16 | z0-octlTape 13 §109.50
. ']
17 §2,530.73 |Tetal cost
18
19 §1,469.27 Ending Balance
20 s -
il \% Total Cost Per Item
22
3
24 Tape [ 510950
25 crmyons [ $42.61
= vaper cips B 81872
28 Card Stocs [ s89.60
29 Text Books (T < 1,255,650
s
32 Makers I $213.50 =Tl Cost Per liem
I ss27.00
32 Paper 55:
33 ciue I s83.25
34 Scissors [ §64.00
35
= pans I $64.35
a7 Pencils [ 571.30
38 S0.00 S200.00 $400.00 $600.00 $800.00 $1.000.00 51.200.00 51.400.00
35 L: <l

1. Select the home tab.

2. Click on the chart.

3. Select the font you want by selecting the icon shown above.

€ Created by Mallory

Forn|

1.35%
08y
13.18%
5.35%
31.39%
2.24%
0.47%
1.09%
2.74%

m
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How Do | Insert A Text Box In Excel?

Below are instructions on how to insert a text box into Excel.

Inserting a text box

Formulas Data Review View

1. Select the Insert tab.

2. Click Text Box.

BYU-Idaho Online | GS107 Page 84



BYU-Idaho Online Knowledgebase

Inserting a text box continued

M o L L = F

o.—-—-ﬁ'

g

1. Click and drag to the size you want.

2. Release and enter text.

Created by Mallory
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Filter data by color

Instructions for the foreign box office assigment part of
filtering data.

wiwiiie Total Foreign Box Office Sales
$2,023,411,357.00
$1,548,943,366.00
$1,122,000,000.00

$1,019,442,583.00
$896,200,000.00

Select the data of "Total Foreign Box Office Sales"
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©-

. ¥ atetun - [N
) ] " A
. - e = Z?T
»e e . J Coer %+ Sort Smallest to Largest

Y Filter

1. On the Home Tab click on the "Sort and Filter" icon.
2. Click on "Sort Largest to Smallest"

I % + Sort Largest to Smallest l
ti| Custom Sort... o
\H'/.

Movie Title Box Offi
Avatar $760,50
Titanic $658,67
Star Wars Ep. VII: The Force Awakens| $936,66
Jurassic World $652,19
The Avenge $623,27

Change the background color to yellow of third movie title

BYU-Idaho Online | GS107

Page 87



BYU-Idaho Online Knowledgebase

Movie Title Bo» Zresn A
Avatar §7 @ cear~ g 34 SortAtoz
o . s ivSortZto A
;Itan‘:\j Ep. VIl The F A 9 sg G ] Custom Sort... |
tar .ars p. VIl: The Force Awakens —
Jurassic World S6
The Avengers S6
1. Select the 5 movie titles.
2. On the Home Tab click on the "Sort and Filter" icon and click on Filter.
Movie Title Box Office USA |Box Office Worldh
Avatar =N $760,507,625.00 $2,783,918,9
Titanic $658,672,302.00 $2,207,615,6
Star Wars Ep. VII: The Force Awakens P $2,058,662,2
Jurassic World sort $1,671,640,5
The Avengers © $1,519,479,5
T ————
— L 1 9
1. Adrop down arrow will appear, click on it.
2. Onthe "Sort" section click on "By color" box.
3. Click on Cell Color, select the blue color.
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PowerPoint
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How Do | Edit The Layout Of Powerpoint?
(copied)

Below are instructions on how to edit the background theme and the text.

Edit Theme

Browse for Themes...
[5g) Save Current Theme...

1. Select the design tab.
2. Select the drop-down arrow, as shown above, to view different themes.

3. Select any theme with a green background.
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Title Font

Insert Design Transitions Animations Slide Show Review View Shape Format
X = = == = [
L. dbou 0=, Elwounr  frrachetns )48 [-|[As]a-] A0 | E=llEl) (= 25 (E) TRy | [ad)- [8' = E‘. [
Copy ~ @ Reset L
Pafte New . B I U abe X; AV 4~ === Ax - Convert te Picture Shapes  Text Arrange  Quick
<7 Format Sige ) Section © = 2l | A8 LA~ E SmartArt Box Styles

The United States of America

(€]

.The Civil War -

The Uni ted States of America

A presentation by
John Doe

1. Select the home tab.

2. Highlight the text you want to change.

3. Select the font tab and choose which font to use.

4. Select the color tab shown above and choose which color to use.
5. Follow steps 1-4 for the title on slide 2.

6. Follow steps 1-4 for the title on slide 3.

7. Follow steps 1-4 for the title on slide 4.
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Body Text

The Civil War

@

0
A presentation by
John Doe
L

1. Select the home tab.

2. Highlight the text you want to change.

3. Select the font tab and choose which font to use.

4. Select the color tab shown above and choose which color to use.
5. Follow steps 1-4 for the text on slide 2.

6. Follow steps 1-4 for the text on slide 3.

€ Created by Emily H
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How Do | Edit The Slide Transitions?
(copied)

Below are instructions on how to edit the slide transitions and the duration of the transition.

Slide Transitions

\ - !

Aandom Bae

The Civil War

A presentation by John Doe

1. Select the Transitions tab.
2. Select the Wipe transition option.
3. Select Effect Options.

4. Select the option From Top.
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Duration of Slide Transitions

The Civil War

A presentation by John Doe

1. Select the Transitions tab.
2. Next to the word Duration, change the time to 1.5-2.0 seconds.

3. Select the Apply to All option.

€ Created by Mallory
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How Do | Insert An Image Into
Powerpoint? (copied)

Below are insturctions on how to save, copy, and insert an image from the web to powerpoint.

How to Save Images

'@h’

-

) f ’ Open Link in New Tab
- Open Link in New Window
Open Link in Incognito Window

Save Link As...
Copy Link Address

Open Image in New Tab
Save Image As...

Copy Image

Copy Image Address
Search Google for Image

Inspect

Use this link if needed: http://www.byuiedtechlab.com/ppt-p-content.html

1. Right click on the image.

2. Select Save Image As...
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Saving Images Continued

@ https://www.google.com/search?hl=en&safe=activefitbs=isch:1&g=Abraham+Lincoin&og=&tbm=ischigws_rd=ssl#gws_rd=ssl&imgrc=zJ7IrNuwfS-jrM:

Save As: i | ¥

Tags:

Where: [&] Downloads ﬂ

Tormat: JPEG image E

1. Label what to save the image as.

2. Select where to save the image.

3. Select the Save button.
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Inserting Image into Powerpoint

1. Select the insert tab.

Presentation

View

L1 = q ; (.Y -

A LN

e n B EHQ A4 BED I

Shapes SmartArt Chart Hyperiink Action  Comment Header & WordArt Date & Slide Object  Eg
Footer Time Number

» Abraham Lincoln was the President of the United
States of America

2. Click on the Pictures option.

3. Select Picture from File...
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Inserting Image Continued

. — . =. . . =

O > |I= E O Downloads Q. Search ®
Favorites

E Al My Files
¢ iCloud Drive
?,5‘.\: Applications
[l Desktop

@ Documents
© Downloads

<
&=
0

Abe Lincoln .jpg

Devices

Remote Disc %be Lincoln .jpg

Shared
are JPEG image - 21 KB o

@ Al Created Today, 10:20 AM
Modified Today, 10:20 AM

Mel:i.:a Last opened Today, 10:20 AM

Cancel Insert

Options

1. Select the image file.

2. Click Insert.

€ Created by Mallory
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How Do | Insert A Hyperlink Into
Powerpoint? (copied)

Below are instructions on how to find the URL of an image and then insert a hyperlink into
Powerpoint.

Provide a Hyperlink

MR I . N oe——s D e———S Y 7T e

Jefferson Davis

Visitpage  View image Yr5ave  View saved

1. Select the image.

2. Select the option to Visit page.
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Hyperlink Continued

& Secure https://www.nps.gov/resources/person.htm3%3Fid%3D173

Jefferson Davis

Jefferson Davis

Natinnal Archives and Rerneds Administeati

1. Highlight the URL

2. Right click to copy.
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Inserting Hyperlink

Paaa) T . [ i .Y .
-2 ahr G W f S A-BED T Q |
i . Shapes SmartArt Chart Hyperlink Action Commeé eader & WordArt Date & Slide Object Equation  Symbaol A

Footer Time Number

» Jefferson Davis was the President
Confederate States of America

1. Select the Insert tab.
2. Click on the Text Box option.

3. Create a text box at the bottom of the slide.

Inserting Hyperlink Continued

©

. Image Source:
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1. Right click in the text box.
2. Select the Paste option.

3. Press enter to activate hyperlink.

Created by Mallory
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How Do | Insert An Animation Effect?
(copied)

Below are instructions on how to add an animation effect in Powerpoint.

Edit Animation Effect

@5 5 beview View

ration:

¥ Effect Options
From Top

Property: |~ From Bottom ]
From Left I

From Top-Right
R From Bottom-Left
Smooth E From Bottom-Right

@he United States

» Abraham Lincoln was the President of the United
States of America

o - Jop. B O

1. Click on the image.

2. Select the Animations tab.

3. Select the Fly In option.

4. An Animations box will appear.

5. Next to where it says Property, select From Right.
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Animation Effect Continued

ANFFENONS [ T R
G b 5 4 S - P swri: OnCEok
* * % K[k k X W . ke 2 -
Ao Iy — FlColor  OrowBhisk  Une Gt SBn Toaaped Dot | nerion | ot Aieaion AT (© burstion: 0050

« From Leit
From Right
Afier animationd  Epom Top  eft
Sound: From Tog-Right
From Bottom-Laft
Smooth Stan From Bastom-fight
Smooth End =
Bounce End
AL TR TR

 Timi
» Jefferson Davis was the President of the =
Confederate States of America

Follow the same steps as above.

1. Select From Left option.

€ Created by Mallory

BYU-Idaho Online | GS107 Page 104



BYU-Idaho Online Knowledgebase

How Do | Add Animation To A Shape?

Below are instructions on how to add entrance, emphasis, and exit animation effects to a

shape.

Inserting A Shape

Home Design  Transitions  Animations Slide Show Review  View

Q/ g NNSTLL 22

Rectangles

Basic Shapes

EO®AMLFAO®OS
¢ oo OO L”r

e_n.e-o-—b oW x @

Noon) €

Block Arrows
= 4= F J & § 4 &
G & U N = = > >
d@ & N

= - a = \' » X SmartArt - L 3
s -

;;we Table Pictures Scraonshot Agd-i Scanil i haren
' /%\\.IOIA'LI-!G
[N S S

B

L
¥
)

B

)

1. Select the Insert tab.
2. Click Shapes.

3. Select a shape.
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Entrance Animation Effect

asig Shape Format
Preview ' . Emphasis  Exit Path Cricet  Acimation
Agpew fincly Pychartc. Dt":"m L 1. Effects Effocts Animatian  Optlons Pang

—
. Basic

*:
-
=

iwedg Weewal Wipe
Subtle
l l C
Expand Fade ded Swivel aded Zoom
Moderate

1. Click on the shape.
2. Select the Animations tab.

3. Select an animation effect.
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Edit The Timing

Animations
# Effect Options
o o.r Timing
\-/ Start: On Click
Dura t 0.5 seconds (Very Fast)
o Delay: o0 seconds
Repeat: nena)

Rewind when done playing

 Text Anamations

1. Click on the number one by the shape.
2. Select the Timing optioin.

3. Change the Duration time.
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Emphasis Animation Effect

Home Inzart L—JE'EIﬂ_'I Transitions Animations Slide Show Review View Shape Format

e **:&f* B B ae

Fill Coler GrowiSarine Ling Goler Soin Tearmpatency

= o s
© (2) b ok ok

tmnum-u-l :nr\d-mnu-y :mlmlhn e

g Ughien  Ojecs Calar
a7

Teesar

1. Click on the shape.
2. Select the Animations tab.
3. Click on Emphasis Effects.

4, Select an animation.
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Edit Timing And Start

Animations

[x]

» Effmct Options

v Timing

Starl: < On Click
With Previous
© outor: T

FAE

After Previous

Delay: To T Zeconds

Repeat: (nona)

Rewind when done playing

o ¥ Text Animations

1. Click on the number two.
2. Change the Start to be After Previous.

3. Select Duration and change the timing.
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Exit Animation Effect

Insert Design Transitions Animations Slide Show Review View Shape Formatl

* K kfk Kk k X, = e Vg B

lun.-nr Bings Chacerrbe. sspive in Fiyn ok n Rgrdpm & EE Bt
:
(3 kX oac X *

4 ';,_, e ——
(2) * wx 2AS w

**0
i’x-‘:‘:‘(

Faded Swheal  Faded Zoam

K H K

1. Click on the shape.
2. Select the Animations tab.
3. Select Exit Effects.

4. Select the animation.

¢  Edit the timing and start to be the same as the previous animations.

€ Created by Mallory
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How Do | Insert And Edit Shapes In
Powerpoint? (copied)

Below are instructions on how to insert and edit shapes in Powerpoint.

Insert Two Star Shapes

Design Transitions Animations Slide Show Review View

1= - x B OE QD 4]

‘& WordArt D
Recently Used Shapes I r ]

E\\I.lAll#lCC'

Y Y i Store

jctures Screenshot a My Add-ins

LL222AN07

Basic Shapes

EOALNFAS®SEOO000D
¢ 6O L7+ 8 W

1. Select the Insert tab.
2. Click on the Shapes option.

3. Select the star shape.
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Changing the Color of the Shapes

Transitions Animations Slide Show Review View Shape Format
il z- ARz BB = 0l
a Abc| |Abc| » I = L\ A A b — =l — Iﬂj
Text Fill [~ Bring Send  Selection Rm_)rder
4 No Fill Forward Backward Pane Objects

Theme Colors

N ErEEEEEE @

L csatii

Standard Colors

[ [ [ ] ]

& More Fill Colors...
[a2] Picture...

| Gradient

Texture

1. Select the shape.
2. Select the Shape Format tab.

3. Click on the Shape Fill option.

€ Created by Mallory
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How Do | Insert An Audio Clip Into
Powerpoint? (copied)

Below are instructions on how to download and insert an audio clip into Powerpoint.

Download the audio clip

CONTENT FOR PRESENTATION PRACTICE

Images:
Images of Abraham Lincoln
Images of Jefferson Davis

Sound Effect of Cheers | . Open Link in New Tab

QOpen Link in New Window
Open Link in Incognito Window , N A
“Note: To download your | select "save link as". This will download as an MP3 on

your computer m
o Y Copy Link Address
) Inspect

Slide Text (2]

Add to iTunes as a Spoken Track -
I « Abraham Lincoinwas e Presigent orthe united States of America

Jefferson Davis was the President of the Confederate States of America

1. Right click with the mouse on the Sound Effect of Cheers button.

2. Select Save Link As...

€ Sound Effect of Cheers button is found on the Ed Tech Lab Website:
http://www.byuiedtechlab.com/ppt-p-content.html
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Audio clip continued

Save As: applause_sound_sffect (1)
Tags:
Where: B8 Downloads

CONTACT

L4

Format: MP3 audio

CONTENT FOR PR

Cancel

Images:

Images of Abraham Lincoln

0—

Images of Jefferson Davis

Sound Effect of Cheers

*Note: To download your audio clip, right click the button and select "save link as™. This will download as an MP3 on

your computer.

1. Select MP3 audio as the format for the Sound Effect of Cheers.

2. Click the save button.
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Insert audio clip

5 E QD 4 BE

Commanl  Tazt  Weate & Wadard Date & Side  Objeet  Coucen Spn
Bos Fooier Tme Humbor

The End

1. Select the Insert tab.
2. Select the audio icon (as shown above).

3. Select Audio from File...
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Insert audio clip continued

Chaose Audio [
" M| <|> @ =) Zm~ | B Downloads s & || 9 ) Q search
Favarites
E All My Files effect. mp3
% Applications —
[ Deskiop
B Documents

(]

Shared applause_sound_effect.mp3

Options Cancel Insert

1. Select the audio clip you want to use.

2. Click the insert button.

€ Created by Emily H
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How Do | Create An Audio Narration Of A
Powerpoint And Make It Automatic?
(copied)

This tutorial will show you how to make an audio narration of the presentation.

Create an audio narration of presentation

Har
B & B B 2 [l&
= s == 9 V' Use Timings
Play from  Playfrom Presenter  Cusiom
Start  Current Ske  View li Timngs fSiic . Mglnnm Beginning

h—4

The Civil War

1. Select the first slide in the presentation.
2. Select the slide show tab.

3. Select the Record Slide Show button.
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Audio narration continued

= Asralim Lincodn wa e Presidlem of e
Unived S of Amesies

The

A presentation by
John Doe

1. After clicking the Record Slide Show button, the presentation will immediately begin recording.
2. Speak aloud into the microphone to narrate the presentation.

3. When finished recording the first slide, click the space bar on the keyboard to move to the second
slide.
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Audio narration continued

» Abraham Lincoln was the President of the
United States of America

Q You will click the space bar to cue in each slide transition and each slide's animation(s).

Example: You will click the space bar to cue the picture of Lincoln to "fly in" from the
right.
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Audio narration continued

The End

©)
©,

1. When you arrive at Slide 4, say "The End".

2. Click the play button underneath the audio clip icon (as shown above) to play and record the
sound effect of cheers.

3. When finished recording the presentation, hit the space bar to end slide show recording.
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End audio narration and recording

(1)

The total time for the slide show was
0:00:07. Do you want to save your slide
timings?

Click to add notes

1. When finished recording the presentation, click the space bar to end slide show recording.

2. When this box appears, click the yes button to save your recording and audio narration.

Q@  Recording the slideshow this way makes the PowerPoint automatic. View the slideshow to
make sure it is automatic.

€ Created by Emily H
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How Do | Put an Action Button in
Microsoft PowerPoint?

The action button in Microsoft PowerPoint allows you to use a provided button to connect your
slide to other slides in the presenation, and outside links.

Putting an Action Button in PowerPoint

cee DN H v- -
Insert Design Transitions Animations Slide Show Review View

r_ — Cut [+ B Layout =
L1 Copy = ) Reset
Paste Mew - - -
< Format Slide 2= Section v

Select the "Home" tab.
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Finding the Action Buttons

1. Select the shapes button.

- - 2 - Shape Fill
— I

S Qe U N =5 = >0 T 44

Equation Shapes

_+—XE]==

t Flowchart

EeeFEERNrFeoeodV
e v AvWmO®O®I ¢AVED

Stars and Banners

WO 4+ o ok O 0 B i S B
W AN T p NN

Callouts

K el
ol i o
Action Buttons Ag/
HEEEEeE HEN

2. Scroll down to find the "Action Buttons" section.

3. Select the "Action Button" you wish to use.
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The Hyperlink Button

I -
= = = = AL . [rmiinet +n P P Tmnsh A — & o
s Action Settings ="
QUEECEEE Mouse Over
Action on click
. ' None
Hyperlink to:
Click to (@e°
Last Slide =
~ Run program:
Run macro:
— | — - —
. B Object action B
— Clﬁ to add text R
| &
NP T
| Play sound:
[MNo Sound] °
L
Width: 152"
_

1. Click and drag to insert the action button onto your slide.

2. An "Action Settings" screen will pop up. Select the "Hyperlink to:" option.
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Select a Destination

Action Settings

Action on click

Next Slide
Previous Slide
First Slide

v Last Slide
Last Slide Viewed
End Show
Custom Show...
Slide...
URL...
Cther PowerPoint Presentation...
Cther File...

Play sound:
[No Sound]

Cancel

<3

Select the destination for your action button.
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Hyperlink to an Outside Page

B8 E‘u:' AITARGE gl:,ltt g Shape Outiine -
Mouse Click  Mouse Over
Action on click
" None
# | Hyperlink to; | 1 O
URL... z I Hyparfink ta LAL
Aun program: :
URL: | https:) fwewwyoutube.comjwatch s -_=P4tZjRig
Cancel
Play sound:
[No Sound]

e ()@

1. If you choose to link a URL, another box will pop up. Copy and paste the URL into the designated
spot. Click the "Add" button to add your hyperlink.

2. Click "OK" to complete the process.

€ Created by Lucy
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How to Insert and Play Audio Across the
Slides

Below are Instructions on how to insert an audio clip and make it play throughout all the slides

Download the Audio Clip

Follow the directions below to complete the PowerPoint assignment:

« Open up a new, blank PowerPoint presentation.

« Choose any presentation theme with a green background. (Click here for tutorial &)

« Add 3 additional slides.

« Title the presentation “South American Animals” and add your name as the subtitle.

« Select 3 South American Animal pictures from the zip file provided.

« Insert the animal pictures on the next three slides (one on each slide). (Click here for tutorial )

« Title those slides with the name of the animal pictured.

« Download the Kalimba.mp3 file and insert it into the first slide of the PowerPoint. (Click here for tutorial) e
« Format the audio file to play across all the slides. (Click here for tutorial)

« Save as “Animals_Last Name, First Name" and upload the presentation to I-Learn.

Additional help can be found at http:/byu-idaho.screenstepslive.com/s/17066/m/65785/c/199211 .

Download the following documents:

2. Kahm\)am\ﬂw

Save link as... \

- ‘

1. Right click with the mouse on the "Kalimba.mp3"
2. Click on "Save Link as..."

BYU-Idaho Online | GS107 Page 127



BYU-Idaho Online Knowledgebase

Save the Audio

si @ savess
« v 4 £ » ThisPC » Documents w|@  Search Documents »

Qrganize * Mew folder =2
L Date medified Type Size (&) Publish %, Edit

A Quick access

| Documents *
J Downlosds # e
=

|=] Pictures »

Mame

No itemns match your search.

J Music
B videos
& OneDrive
[ This PC
¥ Network
[ 4ANDERSENT

[ SMCK321-16504
T spackassotRste ¥

File name:

Saveas type: | WLC media file (.mp3)

I Download the following documents:

1. Animals zip file e e
2. Kalimba.mp3 e -

3. Assignment example &

1. Select ".mp3" as the audio format.
2. Select where you want to save it, choose a place where you can easily find it.

3. Click the "Save" button.

Insert the Image

£ Har

==

apiE 4 mEFE O T O 04

~—@

B+ . + =
Mew | Tsble Picturdk Online Scieenshot Photo  Shapes SmartAt Chart gy aggins - Fypeilink Action  Comment  Ted  Hesder WordAn Dste& Siide Object | Equation Symbol  Video [Audia| Screen
Slides Pidwres  *  Album= - Bex GFooter = Time Humber . « | = Recording
Siites | Tables Images lustrations Adding Links Comménts Test Symibels 1 Audio an My PC..

Becord Audio..,
Audia on My PC .

Insert audic from your computer or
From ether carmputers that yous e
connected o,

1 o
SOUTH AMERICAN ANIMALS

&Sy TA

@ Tell memore

SOUTH AMERICAN ANIMALS
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1. Select the Insert tab.
2. Select the audio icon (as shown above).
3. Select "Audio on My PC..."( If you a Mac, select "Audio from File...")

Make the Audio Play Across the Slides

SOUTH AMERICAN ANIMALS

GS 107 TA

Click on the Audio icon.

Click on the Playback tab

Check the box "Play Across Slides"
Click on "Start Automatically"

A wWwnN =

€ Created by Guillermo S
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Weebly
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How Do | Create A Weebly?

Below are instructions on how to set up and create your own blog/website on Weebly.

Create Account

1. If you have already created an accout, select log in.

2. If you are new to Weebly, select sign up and create an account using your information.
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Select a Theme

Choose a Theme

NEW FALL'SEASOMN

T

1. Select the theme you would like to use.
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Website Domain

Choose Your Website Domain

This is the address where people will find your website online. Reserve your domain now,
or close to skip this step and set it up later.

Use a Subdomain of Weebly.com

A great way to get your website started
Available
http:/f | practicescreensteps weebly.com

igter a New Domain
a more professional online presence

http:/fwww. com

Connect a Domain You Already Own
We'll help you connect your domain when you're ready to publish

http:/f | www.example.com

Choose a websit domain. Select a Subdomain of Weebly.com (otherwise you will have to pay.)
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Editing Pages

Build Pages

Blog

Community

About

1. Select the Pages tab.
2. Select the page you wish to edit.
3. Click on the plus button to add a page.
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Building Pages

My Site

HOME BLOG COMMUNITY ABQUT CONTACT

AUTHOR

ARCHIVES

e Archives

CATEGORIES
Al

&) RSS Feed

1. After selecting the page you want to edit, select the Build tab.

2. Drag elements from the tool panel onto the page.

Inserting Elements
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1. Select what you would like to add to the page.

2. Drag and drop the content.

If you want to add content below, above, or to the the side of previous content, move the
icon to wherever you would like to drop it and the light blue line will indicate where it will

drop.

Edit Text

[BR RN SR | ) By A [EEly N W | e W IWLIWE AP IN O 0

Click here to edit.

o

PHILOSOPHY OF
EDUCATION

o

1. Click the text box.

2. Atoolbar will appear. The toolbar gives you the option to edit the font and size of the text.
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Inserting An Image

=1
Select images from: S ~ ] ®
My Computer Search Favorites Image URL

©
Drag photo here

' Upload a photo from your computer .

o

1. After clicking "Upload Image," this box should appear. The first option is to upload photo from
your computer.

2. There is also the option to search for an image from Weebly. (Be sure to use the "free photos"
tab.)

3. Another option is to use an Image URL (be sure to follow copyright laws when using a photo from
the web.)
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Uploading A File

1. Select File.

2. Drag and drop the icon onto the Weebly site.
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Uploading A File Continued

HOME CONTACT
___————' e
PHILOSOPHY OF Pogition . Click here to ed
EDUCATION

e

Click here to upload file

1. Click on the file.

2. Select "Upload File".
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Uploading File Continued

Drag a file here

Upload file from your computer

1. Click Upload file from your computer and select the file you would like to upload.
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Publishing Weebly Site

PHILOSOPHY OF
EDUCATION

1. Once your weebly site is completed, click on the blue "Publish" button in the right hand corner.
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Publishing Continued

Choose Your Website Domain

This is the address where people will find your website online.

Use a Subdomain of Weebly.com

A great way to get your website started
http:// | practicescreensteps \%bly.com

For a more professional online presence

Register a New Domain \

http://www.

Connect a Domain You Already Own
Cheoose a plan and connect your domain in the next step

http:/! | www.example.com

&—

1. Select the address you would like to use.

2. Select Continue.

A Be sure to use the published URL when accessing (or submitting) your weebly site. DO
NOT copy and paste the URL from the search bar, it does not give others access to view
your site.
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Creating a Subdomain on Weebly

Below are instructions on how to create a subdomain for your Weebly website.

Choose a Theme for Your Website

Choose a Theme

You can easily change this later. Any theme can have a Store or Blog.

FITNESS
HANDLED.

I'm Brooke

I'm James. This is my year of travel.

1. Find a Theme of your choice.
2. After selecting a Theme, Click on "Choose" to start your Weebly site.
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Website Subdomain

Choose Your Website Domain

This is the address where people will find your website online. Reserve your domain no
close ta skip this step and set it up later.

Use a Subdomain of Weebly.com
A great way to get your website started

Begriter s New Doman

Connect 3 Domain You Already Own

el S - o e ety

1. Click on the first option "Use a Subdomain of Weebly.com"
2. Create your own address.
3. Click on "Continue" to finish setting up your Subdomain.

@© Don't choose the other two options, they will charge you for a monthly plan.

€ Created by Guillermo S.
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How to Use the Pages Tab on Weebly

Below are instructions on how to use the Pages tab on Weebly to create different tabs in your
website.

The Pages tab

1. Click on "Pages" to see all your current tabs in your website.
2. Select the page you want to edit. Each page has a symbol representing the type of page they are
(Standard, Blog, Products, etc.)
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Add a New Page

Build Pages Build Pages

Pages

Standard Page

Blog Page

Category Page I e
b4

Product Page

External Page

Non-clickable Menu

1. Click the "Plus sign"
2. Choose the type of page you want to add to your website.
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Edit a Page tab

Build Pages ( Build Pages

Untitled

Blog

HEADER TYPE

SLCRUR Header

Contact Visibility

Portfolio SEO Settings

Click on the Page you want to edit.

Give a name to the page.

Choose to add or delete header to this page.
Choose to make this page "Public"
Advanced searching options.

AN

¢  Ablog page and a standard page are different, make sure to choose the one you need for
the assignment.

Created by Guillermo S.
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Default
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How Do | Complete a Mail Merge?

The Mail Merge function allows you to combine information in Microsoft Word and Microsoft
Excel. The function is most often used to create letters, but can have other purposes as well.

This article will show you how to merge a document in Microsoft Excel with a document in
Microsoft Word.

Create an Excel Document

M Ew- % DataFile

Insert Page Layout Formulas Data Review View

“*
: ‘?x
|

= = Conditi IF tting * L=+1
Calibri (Body) ~+| 12 +| A= Aw = 5P General - [ jConditenatienpaiiioy - Q .
a & o = = = & Format as Table ~ I—I
Paste B 9 *.0 .00 Cells Editin
& B | I |U |l M MR $ % > w45 4/ Cell Styles » J
G10 . fx v
A B C o] E F G H | ] K [ M N
1 ‘First Name Last Name Address City State Zip Parent First Name Parent Last Name Parent Title He/She he/she his/her him/her '
2 8
3 Cookie Monster 123 Sesame 5t New York NY 85023 Brownie Monster Mrs. He he his him
4 | Harry Potter 4 Private Drive Little Whinging Surrey 65335 Petunia Dursley Mrs. He he his him
5 |Frodo Baggins 425 Bagend The Shire Middle-Earth 89086 Bilbo Baggins Mr. He he his him
6 |Arowen Undomiel 1 Rivendell Middle-Earth 50532 Elrond Undomiel Mr. She she her her
7
8
9
10 | I
L ]
11

1. Make an Excel Document with the information that you wish to use in your mail merge.

2. Make sure to have headings that title each section.
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Save the Excel File

Edit View Insert Format Tools Data Window Hel

New Workbook

Open...
Open Recent

Close

Restore
Import...

Reduce File Size...
Share

Restrict Permissions
Passwords...

Page Setup...
Print Area
Print...

Properties...

MNew from Template...

3N
3P
EJepvout Formulas Data
> ) * 12 v As Aw = E
%w I v A & A A v __ __
8S = j— LEILE
{r3s
D E F
L City State Zip
me S5t New York NY 89
me 5t New York NY 85
\Drive Little Whinging Surrey B5
ind The Shire Middle-Earth B
1 Rivendell Middle-Earth 90

1. Click the "File" button.

2. Click the "Save As" button.
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Name the File

o Save As: | DataFile v
o ~—y

Tags:

Where: | @ Documents

Online Locations File Format: = Excel Workbook (.xlsx)

Options...

cancel | (NN

1. Name the file something that you will remember.

2. Click the "Save" button.
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Create a Word Document

M E wv- = Document1

Insert Design Layout References Mailings Review
Y = = = — T
mn- Calibri(Body) v |[12 ~| A~ A £~ AP I= v i= - i=- &= #=

& B I Ulrake X, 2| AL - A+ [E = = =

January 27, 2013

Styles Styles
Pane

I want you to know what a pleasure it is to rulv a joy to have work with at the school
and have in class. | hope that you are pleased grogress so far this year.

I don't knoold you, but currently our school is selling band candy to raise money for
the marching 0. By showing your suza gr the Marching Razorbacks and buying some
band candy, you will be demonstratil ‘@ hat happens at school is important to you.

| appreciate your time and support in this matter. By participating in activities like this, we can
all help the Sunnydale school experience be a pleasant one for everyone involved.

Sincerely,

Principal Snider

Create a Word Document. Leave spaces where you want to insert your data fields. These are the

spaces where information specific to each person will go.

Combine the Excel Document and the Word Document

Document

M A wo- =T
Insert Design Layout Referend ' Mailings Review

C T

&Y

Edit Filter

(2
Envelopes Labels Start
Merge

Select
Recipients

Insert

ecipient List Recipients Merge Field

View

Preview
Results

Jo

1. Select the "Mailings" tab in the tool bar.

2. Select the "Select Recipients" tab. A drop down menu will appear.
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coee M E ov- = = Documenti
Home Insert Design Layout References Mailings Review View
[] :_.' | = - = O o 25 - «ffncks
g 2y B OB LR BIE > M
Envelepes Labels Start Mail | Preview TQ Find Recipient
Merge | Results

B Apple Contacts...
€' FileMaker Pro...
January 27, 2013

Select the "Use an Existing List" button. This will allow you to select which document you would like
to merge.

Select the Document

Choose a Data file.

EX EeR= @ gm . | [ Documents ® i [ Q,
Favorites Eﬁ DataFile o
- ] My Cmaps
Y iCloud Drive B My Cmap
- First Name  Last Na
¥ Applications Elmo Red
E Desktop Cookie Monster
Harry Potter g
B Documents Frodo Baggins ‘
o Downloads r\mwcn}(]_guﬁmie]
Devices
Remote Disc
Shared DataFile
@ Al..
37 KB
Media Created Today, 10:53 AM
n Music 1" Modified Today, 11:21 AM e
\-...-,
Options Cancel Open

A window will open.

1. Select the file that you just created and saved in Excel.
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2. Click the "Open" button.

Warning Window

This file needs to be opened by the Excel
Workbook text converter, which may pose a
security risk if the file you are opening is a
malicious file. Choose OK to open this file
only if you are sure it is from a trusted

source.
[ Cancel

Select "OK" when this window pops up.

Open the Workbook

Open Workbook

Open Document in Workbook:

Sheetl

Cell Range:

The "Cell Range" default setting is "Entire Worksheet". Do not change any settings.

Select "OK" to combine your Excel Workbook with the Word Document that you have created.
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Starting the Merge

January 27, 2013
| /

I want you to know what a pleasure it is to teach. is truly a joy to have work with at the school
and have in class, | hope that you are pleased with progress so far this year.

I don’t know if_has told you, but currently our school is selling band candy to raise money for
the marching band. By showing your support for the Marching Razorbacks and buying some
band candy, you will be demonstrating to_that what happens at school is important to you.

| appreciate your time and support in this matter. By participating in activities like this, we can
all help the Sunnydale school experience be a pleasant one for everyone involved.

Sincerely,

Principal Snider

Put the cursor where you want the first Merge Field to appear.

Insert the Merge Field

Design Layout References Mailings Review View
] ]
Lo - — J? T 1 ']
5 &3 8 v,r: H H ‘
Start Mail  Select Edit Filter Insert Preview TD Find Recipient
Merge Recipients Recipient List Recipients Merge Field Results

4

Select the "Insert Merge Field" button in the toolbar.
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Choosing the Field

s K

vhat a
in class

old you
3y shoy
be der

.‘\_T ?_T

First_Name
Last_Name
Address

City

State

Zip
Parent_First_MName
Parent_Last_Name
HeShe

heshel

hisher

himher

<H

DF

shen je
1 with

selling
archim
ppens

e and SUPPOrt I this matter. By participz

Select the field you wish to insert into your document. Again, it will automatically insert where you

have your cursor.
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The Inserted Field

lanuary 27, 2013

«Parent_Titles

| want you to know what a pleasure it is to teach . «}
the school and have in class, | hope that you are plea

| don't know if_has told you, but currently our school
the marching band. By showing your support for the
band candy, you will be demonstrating to_that what

This is what the inserted field will look like.

Completing the Merge

January 27, 2013

«Parent_Title» «Parent_First_Name» «Parent_Last_Namex»
whddress»
«Citys, uState» «Zip»

| want you to know what a pleasure it is to teach «First_Name». «HeShex is truly a joy to have
work with at the school and have in class. | hope that you are pleased with progress so far with

whishers progress so far this year.

I don't know if «First_Name» has told you, but currently our school is selling band candy to

raise maney for the marching band. By showing your support for the Marching Razorbacks and

buying some band candy, you will be demonstrating to «himher» that what happens at
«hisher» school is important to you.

| appreciate your time and support in this matter. By participating in activities like this, we can

all help the Sunnydale school experience be a pleasant one for everyone involved.

Sincerely,

Principal Snider
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When your letter is completed, it will look similar to this, with the fields in place of the spaces that
you left in your document.

Complete the Merge

Mailings Review View

e - t M 4 1 b M Merge Range All =
-
4 —_—
Insert Rules LUpdate  Preview 0 Find Recipient To
5 Merge Field Labels Results

Select the "Finish & Merge" button on the right.

A dropdown menu will appear. Select the "Edit Individual Documents..." option.
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January 27, 2013

New York, NY 85023

Iwant you to know what a pleasure it Is to teach Elmo. He is truly a joy to have work with at the
school and have in class. | hope that you are pleased with progress so far with his progress so
far this year.

Idon’t know if Elmo has told you, but currently our school is selling band candy to raise money
for the marching band, By showing your suppert for the Marching Razorbacks and buying some
band candy, you will be demanstrating to him that what happens at his school is impartant to
you.

I appreciate your time and support in this matter. By participating in activities like this, we can
all help the Sunnydale school experience be a pleasant one for everyone involved.

Sincerely,

Principal Snider

BYU-Idaho Online Knowledgebase

lanuary 27, 2013

New York, NY 83023

| want you to know what a pleasure it Is ta teach Cookie. He Is truly a joy to have work with at
the school and have in class. | hope that you are pleased with progress so far with his progress
so far this year.

I'don’t know if Cookie has told you, but currently our school is selling band candy to raise
meney for the marching band. By showing your suppor for the Marching Razorbacks and
buying some band candy, you will be demanstrating to him that what happens at his school is
important to you.

1 appreciate your time and support in this matter. By participating in activities like this, we can
all help the Sunnydale school experience be a pleasant one for everyone involved.

Sincerely,

Principal Snider

Several documents will appear. The information from your spreadsheet has been combined with the
information in your word document. If you scroll through the documents, you will find that each one
is different.

Created by Lucy
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Where can | find the password for the
syllabus quiz?

Finding the syllabus password.

© This class works sequentially, as you complete one section the next section will open. You
must complete the syllabus quiz before for the next section will open.

Content tab

Select the Content tab

Leaming Model | I-Leam Helpw | My BYUI

GS 107: 02 (Campus); Winter 2017

Content ' Discussions | Quizzes | Assignments | Calendar | My Grades~ | More Tools v

Introduction section

Under the table of content (left side column), click on Introduction
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GS 107: 02 (Campus); Winter 2017

Content | Discussions | Quizzes

Search Topics Q, Introduction
CI Overview
N Bookmarks

F=1 Course Schedule

:= Table of Contents 4

Welcome 2 08

Password

There are two items listed in the Introduction section. The second item is the Syllabus Quiz, at the
bottom of its description you can find the password.
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Learning Model | ILeam Help~ | My BYUI

07: 02 (Campus); Winter 2017

Content | Discussions | Quizzes | Assignments | Calendar | My Grades~ | More Tools =

Search Topics Q Introduction & Print
I Overview
W Bookmarks

51 Course Schedule

i= Table of Contents 3

( ]
Welcome z 50 % 1 of 2 topics complete
Introduction 1

| Syllabus v
=

7| Syllabus Quiz
@® Due March 3 at 11:59 PM
Read through the syllabus.

This is a short quiz designed to make sure you understand the key points in the syllabus. Remember, it is your
responsibility to know all the material contained in the syllabus.

You can retake this quiz as many times as you would like until you get a 100%. You must get 100% on this quiz to
get credit for it and move on.

Once you get a 100% on this quiz, the next section of this course will open.

Password: syllabus

Creating by Guillermo
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Where can | find the passwords for the

instructions quizzes (Power Point,
Spreadsheet, and Word)?

Quizzes' instructions and passwords

Q@  All quiz passwords are in each quiz instructions.

Sections

Learning Model | l-Leam Helpw | MyBYUI

GS 107: 02 (Campus); Winter 2017

Content Discussions | Quizzes | Assignments | Calendar | My Grades<~ | More Tools +

Search Topics Q Welcome - = Print

L Overview

6GS 107
COMPUTER

W Bookmarks

f=1 Course Schedule \'.,; i ;

:= Table of Contents 12
() Download  [E) Send to Binder
Welcome 2
Introduction 1 0 % 0 of 2 topics complete
Presentations (PP) 3 & Welcome to Computer Basics
Spreadsheet (SS) 3
_‘; What Are the Due Dates? ~
Word Processing (WP) 3

©

1. Click on the Content tab
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2. Select the section you want to work on (not all 3 section will be available at the same time,
remember that in order to see the next one you have to finish all the assignments in the previous

section.)

PDF Instruction's document

Leaming Model | Leam Help+

GS 107: 02 (Campus); Winter 2017

Content | Discussions | Quizzes | Assignments | Calendar | My Grades+

Search Topics a Introduction and Instructions -~

|« & COMPU

) Download ~ [E) Send to Binder

T-B-R

0% O of 3 topics complete

Brmsertatis  otrodus hor

7| Presentation - Instructions

@® Due March 10 at 11:59 PM

Presentations (PP) 3
You can take this quiz once. Take this quiz after reading the following:

Introduction and 3 w e
Instructions e —

—

e Prasertatior | serming Rssaurces

BEANSIT ¢

| MyBYUI

| More Tools =

= Print

1. Click on the Introduction and Instructions part of that section.

2. The second Item is the Instructions quiz of that section, under its description click on the

"Instructions" bullet point. It will direct you to a PDF document.
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Passwords

GS 107

COMPUTER HEWASRT C

Instructions

Let's gt busy! There is much to leam and do. Please follow the directions very carefully! Note: when students don't read
all the directions and start assuming without reading, they often end up wasting time. Please read all of the directions
before doing any of the assignments. You must read all of the directions or the other items in this section will not
appear.

Step One;

Review the “Presentation — Leaming Resource™ sheel. Become familiar with the resources document and the different
sections. This will help as you start deing the practices.

Step Two

Opan the practice section. Thare will be several practice assignments and a practic quiz. You will nat be graded on
thess practice assignments because they are primarily for practice. Please take time to leam this technology and use the
resources in this process. You may also refer 1o the syllabus for additional leaming help.

= You will do the 1% practice. When you have completed this practice you will self-grade it and submit the completed
file. When you have submitted the file the next practice will open.

You will do the 2+ practice. When you have completed this practice you will seif-grade it and submit the completed
file. When you have submitted the file the practice quiz will open.

You will do the practica quiz. If you get less than 80% on this quiz you will need to go back and do a few mare
practice exercises (more will appear) — you may do these exercises optionally if you get over a 90%. Do the
practice exercises and retake the quiz as many times as needed, Onge you have gotien above & 90% on the
practice quiz the final quiz and assignment will appear.

Step Thres:

Final quiz and assignment. These two items will be graded and will be the final grade for this section. The final quiz can
only be taken once. Please make sure you feel very comfortable with the practice quiz and assignments before doing the
finals for this section

Good Luck. 1o use the . intemet, [ halp, and other help itemns found in the syllabus as
needed.

You may now take the quiz. The quiz password Is;

+ Read the PDF instructions document carefully before you take the quiz.
* At the bottom of each Instructions document you will find the password for the quiz of that

section.

Created by Guillermo
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Where Are The Other Sections Under The
Content Area?

Paying attention to assignments' descriptions

This class works sequentially, as you complete one section the next section will open. To
do your class work and assignments use the “Content” tab only.

Content Tab

Learning Model | Leam Help~ | My BYUI

GS 107: 01 (Campus); Winter 2017

Content | Discussions | Quizzes | Assignments | Calendar | My Grades< | More Toolsw | Teaching Tools =

Click on the "Content" tab in order to display the sections available.
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Introduction

Leaming Model | IHLeam Help= | My BYUI

GS 107: 02 (Campus); Winter 2017

h Topics

T Overview
W Bookmarks

= Course Schedule

i= Table of Contents

Welcome

Content | Discussions | Quizzes | Assignments | Calendar | My Grades< | Mone Tools =

Introduction = Print

] 50% 1 of2 topics complete

[ Introduction

1][&’ ]

E—4

7 | Syllabus Quiz

Raad through the syllabus.

5 15 a short quiz designed 1o make sure you understand the ey pol
responsibility to know all the material contained in the syllabus.

iNis in tha syliabus. Remember, itis your

You can retake this quiz as many times as you would like until you get a 100%. Yeu must get 100% on this quiz to
get credit for it and move on.

Once you get a 100% on this quiz, the next section of this course will open.

Password: syllabus

1. Under the"Table of Contents" select the "Introduction" section.

2. Read the "Syllabus" document.
3. Read the description of the syllabus quiz before you take it, you need to get a 100% on the quiz.

@ [fyou take the quiz but didn't get a 100% you won't be able to advance to the next

sections. Remember to read each assignments' description carefully.
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Leaming Model | Leam Help= | My BYUI

GS 107: 02 (Campus); Winter 2017

Content | Discussions | Quizzes | Assignments | Calendar | My Grades~ | More Tools +

Search Topics Q Internet & Print

7% Overview
I Bookmarks

=3 Course Schedule

i= Table of Contents 5
Weicome 2 0% D of 2 topics complete
Introduction 1 ) ) )

7 | What is Online Etiquette or Netiquette?
Internet 2 @® Due March 3 at 11:59 PM

Take this quiz after reading about netiquette, You can take this quiz twice (the highest score will be recorded).

Password: internet

7| What is Cyberbullying?

After receiving a 100% in the "Syllabus Quiz" The new section will open.

Created by Guillermo
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How Do | Add Audio Recording To a
Power Point Presentation?

Inserting audio recording in a Power Point presentation.

Slide show tab

@© You need to have already text, transition and animation effects in each slide

COMFY INN

Wlcomat

Amenities and activitles for guests
+ Whiat & there to da?
At the Hotel or Inthe Town?

Hotel Amenities and Activities

1. Go to slideshow #1
2. Select the Slide show tab
3. Click on the Record Slide show icon
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Recording

Hotel Amenities and Activities t";rt:il:me"'t'es e

¢ Dining * Activities

\ Next sequence in the slide

Current slide you are
recording

Curent, previous
and next slides

* Read the text outloud on the current slide by pressing the space bar on the keyboard in order to
see the next sequence/animation text.

* You can check which number of slide you are working on and what slide is next by looking at the
bottom.

+ Check the next sequence/animation of your slide at the right smaller screen slide.

Saving

BYU-Idaho Online | GS107 Page 170



BYU-Idaho Online Knowledgebase

Thue tartal e for the ulidy show was
W OI01:32. Doyl Wil 13 SR 0ur SEe

timings?

2 [N

THANK YOU!

Enjoy your stay at the Comfy Inn!

+ When recording up to the last slide, click the space bar on the keyborad.
+ A saving box will appear, click on Yes in order to save your recording for your whole presentation.

Created by Guillermo
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Where Can | Find The Feedback And
Graded Rubric For My Assignment?

Scores and rubric for graded assignments

Assignments Tab

@© Thisis the only use of the assignments Tab in this course.

GS 107: 01 (Campus); Winter 2017

Assignment Submission Folders

Assignments | Calendar | My Grades< | More Tools <

© Help

View History
100 ~  perpage
‘Submission Folder Score Submissions Feedback Due Date
Na Category
-ro 0 Jan 27,
1) Presentation Practice - The Be Attitudes Submission 2017
11:59 PM
-110 0 Jan 27,
2) Presentation Practice - Down Syndrome Submission 2017
11:58 PM
Prasentation Practice - Civil War Submission -110 ]
Practice Presentation - Master Slide Action Button HyperLink Submission -ro ]
Presentation Practice - Technology In a Classroom Submission .10 0
Prasentation Final Assignment Submission -/180 0 Jan 27,
Attachmonts 2017
. 11:59 PM
[ Presentation Practice - Comfylnn hotel Image.jpg {176.36 KB)
-110 0 Feb 3,
1) Spreadsheet Practice - Business Income Submission 2017
11:58 PM
-110 ] Fab 3,
2) Spreadsheet Practice - Classroom Budget Submission 2017
11:59 PM
Spreadsheet Practice - Class To Do List Submission -Io 0
Spreadsheet Practice - Foreign Box Office Sales Submission -110 0 -
Spreadsheet Practice - School Expenses Submission -110 0 o
Spreadsheet - Final Assignment 150 /180 - 1 :i eb 3,
\ A 2017
Attachments N

[ Picture Excel jog (33.86 KB)

. 11:59PM

1. Click on the Assignments Tab.

feedback)
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Click on the View icon of the chosen assignment in order to see your grade and feedback.

Go to the assignment you want to see your grade and feedback. (Not all assignments have
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Remember not to use the Assignments Tab to submit your documents, because it will
cause problems to the content sections.
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How Do | Create A Graph In Excel?

Below are instructions on how to create and edit a chart in excel.

Using the items in B5:B16 and the data in E5:E16, create
a 3D bar chart and place it under the data

Page Layout Formulas Data Review View Chart Design For

- tor [ . _ - -
W Stere Bing Maps 1z - = L] ol
Pictures Shapes g Screenshot= g Myhdd-is © [ Pecpe Graph Recaenerended
arts
— [ o

Classroom Budget
cccccccccccccc

1. Select the insert tab.
2. Highlight data from (B5:B16).

3. While holding down the command key(Mac)/control (PC), highlight data from (E5:E16).

© [fyouclick twice on one cell while highlighting, your graphic will show the wrong data, and
you would have to start this step again.
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In the bar chart, add data labels to show the dollar

amount for each item

Home Insert  Page Layout

@
0"
°

I Axes L
Il Axis Titles
i Chart Title

i+ DataLabels |

Formulas Data

Review

v » Chart Design Format

........

1 3,180
1 ¥ Gridlines 5. 354
A Legend L]
1 2240
i 0474
i T
1 i
1

187

19 ing B

20

21

= Total Cost Per ftem o

n —4

24 tepe D 530050

gz crwvons I 3361

27 o B $1872

2 [

29 Card Seock §89.60

30 repeots T < o so

3l woters D 52:350 -

32

33 poe T :::

4 e D 53335

35

36 sciors [ 53400

37 ey D 58435

L

2 s D s

40 som S0 S90m S0 SE00.00 L0000 SL20000 $L400.00

a1

1. Click on the graph.

2. Select the Chart Design tab.

3. Select the option to Add Chart Element.
4, Select Data Labels option.

5. Select the "More Data Label Options..."
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Add a legend to the right of the chart

i i practice2
Pagelayout Formulas Data  Review  View 2 )
* - .
L L
Ik Axis Titles »
. ) .t
.I Chart Title ¥ c b E P
I Data Labels >
et > B 45]  si.20 $54.00 1.35%
371]  s2.2s $83.25 2.088
ey - . s|  se.2o $5217.00 13.18%
Bl 5 $213.90 5.35¢%
[ None .90 $1,255.50 31.39%
X
| °e: $89.60 2.248
_ 52 si8.72 0.47%
_ |l Tor .89 543.61 1.09%
16 20-0ct|Tape .50 $109.50 2.74%
= E|ljLeft
52,530.73 Total cost
17 [l Bottom
18
n More Legend Options... $1,469.27 Ending Balance
20
2 Total Cost Per Item o
) 4
23
24 Tape W 510350
Crayons ™ $4351
5 Paper Clips ® $1872
26 Card Stock W 589.60
27 Text Books $1,255.50
28 Markers TS 521350
19 Paper I $527.00
= Glue T 48325
Scissors W 554.00
31 Pens W $6435
32 Pencils SN 57130
33
= S000  $20000 $400.00 $600.00 5800.00 $1.000.00 51,200.00 51.400.00
35
36

1. Click on the graph.
2. Select the Chart Design tab.
3. Select the option to Add Chart Element, and then click on "Legend"

4, Select the "Right"option.
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Change all of the text in the chart to Arial.

Home Insert Page Layout

* 'r\rial '.o v|| A= Aw

T B I U - || |v A -

Chart.o‘ fe
A

A B

24 Taps
25 Cryons
Paper Clips

28 Card Stodk
29 Text Books
] Markers
Paper
33 Glue
34 Scissors
Pens

37 Pencils

38 §0.00

1. Select the home tab.

2. Click on the chart.

3. Select the font you want by selecting the icon shown above.

€ Created by Mallory and Guillermo

45

LE]
62
45
iz

kL
El

W 510050

W s42.61
Bsirz

@ sg0.60

1.20
.25
.20
.45
.30
.80
.52
-89

§54.
$83.
§527.
§213.
§1,255.
589.
$18.7
543,
5109,
§2,530.7

§1,469.

Total Cost Per Item

Formulas Data Review

0o
25
o
a0
50
60

27

WView Chart Design

Ending Balance

I mm— £1,256.50

I s213.50

I ss27.00

D 5325

0 s54.00
W st64.35
W 5730

= Tatal Cost Per ltem

$200.00 $400.00 $600.00 $A800.00 $1.00000 $1.200.00 $1.400.00

Forn|

.35%

08y

L18%
.35%
.39%
L24%
.47
.09%
.74%
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